Thank you for purchasing this product. Lorex Corporation is committed to providing our customers with a high quality, reliable security solution.

This manual refers to the following models:

LNR608 (8-channel)
LNR616 (16–channel)
LNR632 (32–channel)

For the latest online manual, downloads and product updates, and to learn about our complete line of accessory products, please visit our website at:

www.lorextechnology.com

WARNING
RISK OF ELECTRIC SHOCK
DO NOT OPEN

WARNING: TO REDUCE THE RISK OF ELECTRIC SHOCK DO NOT REMOVE COVER. NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a risk of electric shock.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF THE PLUG TO THE WIDE SLOT AND FULLY INSERT.
# Table of contents

1 Important Safeguards ......................................................................................... 1  
  1.1 General Precautions ................................................................................. 1 
  1.2 Installation ............................................................................................... 1 
  1.3 Service ...................................................................................................... 3 
  1.4 Use ........................................................................................................... 3 

2 Getting Started (LNR600 Series) .................................................................... 4 

3 Front Panel (LNR600 Series) ........................................................................... 5 

4 Rear Panel (LNR600 Series) ........................................................................... 6 

5 Basic Setup (LNR600 Series) ........................................................................... 7  
  5.1 Step 1: Connect the IP Cameras .............................................................. 7 
  5.2 Step 2: Connect the Mouse .................................................................... 7 
  5.3 Step 3: Connect the Ethernet Cable ....................................................... 7 
  5.4 Step 4: Connect the Monitor .................................................................. 8 
  5.5 Step 5: Connect the Power Adapter to Power the NVR ......................... 8 
  5.6 Step 6: Upgrade Firmware to Latest Version (if Available) .................... 8 
  5.7 Step 7: Verify Camera Image ................................................................... 9 
  5.8 Step 8: Set the Time .............................................................................. 9 
  5.9 Default System Password & Port Numbers .......................................... 9 
  5.10 Quick Access to System Information ................................................... 9 
  5.11 Connecting Cameras to the Local Area Network (LAN) ....................... 10 

6 Mouse Control ............................................................................................. 13 

7 Remote Control .......................................................................................... 14  
  7.1 Setting the Remote Control Address .................................................... 15 

8 Using the System ........................................................................................ 16  
  8.1 On-Screen Display .................................................................................. 16 
  8.2 Using the Quick Menu .......................................................................... 17 
  8.3 Adjusting Camera Image Settings ......................................................... 17 
  8.4 Using the Navigation Bar ....................................................................... 19 
  8.5 Using the Camera Toolbar ..................................................................... 19 
  8.5.1 Using Instant Playback ...................................................................... 20 
  8.5.2 Using Digital Zoom in Live Display .................................................. 20 
  8.5.3 Using Real-time Backup ................................................................... 20 
  8.6 Using the Virtual Keyboard ................................................................. 21 
  8.7 Adjusting Camera Zoom & Focus ......................................................... 21 

9 Setting The Time ....................................................................................... 23 

10 Recording .................................................................................................. 24  
  10.1 Video Recording Types ........................................................................ 24 
  10.2 Main Stream and Sub Stream ............................................................. 24 
  10.3 Setting up Scheduled or Manual Recording ....................................... 24 
  10.4 Configuring Hard Drive Overwrite .................................................... 25 

11 Search (Playback) ..................................................................................... 26  
  11.1 Playing Back Video from the Hard Drive ........................................... 26 
  11.2 Playback Controls .............................................................................. 27 
  11.3 Playing Back from a USB Drive ......................................................... 27 
  11.4 Using Smart Search ........................................................................... 28 

12 Backup ...................................................................................................... 29  
  12.1 Formatting the USB Thumb Drive ..................................................... 29 
  12.2 Backing up Video .............................................................................. 30 
  12.3 Using Video Clip Backup .................................................................... 30
# Table of contents

12.4 Viewing Backup Files ................................................................. 31  
12.4.1 Viewing Backup Files on PC ............................................. 31  
12.4.2 Viewing Backup Files on Mac ........................................... 34  

13 Managing Passwords and User Accounts ............................................. 37  
13.1 Changing Passwords ................................................................. 37  
13.2 Adding Users ........................................................................... 37  
13.3 Modifying Users ....................................................................... 38  
13.4 Deleting Users ......................................................................... 38  
13.5 Account Groups ....................................................................... 39  
13.6 Adding Groups ......................................................................... 39  
13.7 Modifying Groups ..................................................................... 40  
13.8 Deleting Groups ....................................................................... 40  

14 Using the Main Menu ......................................................................... 41  
14.1 Camera .................................................................................. 41  
14.1.1 Remote Device .............................................................. 41  
14.1.2 Viewing Camera Status ................................................... 42  
14.1.3 Viewing Camera Firmware Versions ................................... 42  
14.1.4 Upgrading Camera Firmware ............................................ 42  
14.1.5 Recording ..................................................................... 43  
14.1.6 Configuring Recording Quality .......................................... 43  
14.1.7 Configuring Snapshot Recording Settings ............................ 45  
14.1.8 Configuring Video Overlay Settings .................................... 46  
14.1.9 Creating Custom Channel Names ...................................... 47  
14.2 Info ........................................................................................ 48  
14.2.1 HDD Info ...................................................................... 48  
14.2.2 Record Info ................................................................... 49  
14.2.3 Version ........................................................................ 49  
14.2.4 Event Info ..................................................................... 50  
14.2.5 Online Users ................................................................. 50  
14.2.6 Load ............................................................................ 51  
14.2.7 Test............................................................................. 51  
14.2.8 BPS ............................................................................ 51  
14.2.9 Log ............................................................................. 52  

14.3 Setting .................................................................................... 52  
14.3.1 Network ....................................................................... 53  
14.3.2 Selecting DHCP or Static IP Address (TCP/IP) ...................... 53  
14.3.3 Configuring System Ports (Connection)............................... 53  
14.3.4 Configuring DDNS Settings .............................................. 54  
14.3.5 Configuring Email Alerts .................................................. 55  
14.3.6 Configuring Switch Settings (Advanced).............................. 56  
14.3.7 Event........................................................................... 57  
14.3.8 Configuring Motion Detection ............................................ 57  
14.3.9 Configuring Video Loss Settings ........................................ 59  
14.3.10 Configuring Tampering Settings ......................................... 60  
14.3.11 Configuring Alarm Input Devices ........................................ 61  
14.3.12 Controlling Alarm Output Devices ...................................... 62  
14.3.13 Configuring Hard Drive Warnings ....................................... 63  
14.3.14 Configuring Network Warnings ........................................ 63  
14.3.15 Storage ........................................................................ 64  
14.3.16 Configuring the Video Recording Schedule ......................... 64
# Table of contents

14.3.17 Configuring Pre-Recording ............................................... 65  
14.3.18 Configuring the Snapshot Schedule ................................. 66  
14.3.19 Configuring Hard Drive Groups (Advanced) ....................... 66  
14.3.20 Configuring Holidays ....................................................... 68  
14.3.21 Formatting the Hard Drive ................................................ 69  
14.3.22 Configuring Hard Drive Type ........................................... 70  
14.3.23 Setting up Hard Drive Mirroring (Advanced) ...................... 70  
14.3.24 Configuring General System Settings ............................... 71  
14.3.25 Setting the Monitor Resolution (Display) .......................... 72  
14.3.26 Saving Your System Configuration to a USB Thumb Drive ........................................................................... 73  
14.3.27 Setting the System to Factory Defaults ............................... 74  
14.3.28 Upgrading Firmware from USB ........................................ 76  
14.4 Shutdown................................................................................ 77  
15 Connecting to Your System Over the Internet on PC or Mac ............ 78  
15.1 System Requirements ............................................................. 78  
15.2 Step 1 of 3: Connect your System to Your Router .................... 78  
15.3 Step 2 of 3: Obtain the system’s Device ID............................. 79  
15.4 Step 3 of 3: Connect to the System Over the Internet ............... 79  
16 Using FLIR Cloud™ Client for PC or Mac ..................................... 83  
16.1 Home Page ............................................................................. 83  
16.2 Live View ................................................................................ 83  
16.2.1 Live View Controls .......................................................... 84  
16.2.2 Opening Live View in Multiple Monitors ............................... 85  
16.3 Controlling PTZ Cameras ........................................................... 86  
16.3.1 PTZ Presets .................................................................. 87  
16.3.2 PTZ Tours ..................................................................... 88  
16.3.3 PTZ Pattern .................................................................. 89  
16.3.4 PTZ Scan ..................................................................... 90  
16.3.5 PTZ Pan....................................................................... 90  
16.4 Playback................................................................................. 90  
16.5 Playback Controls.................................................................... 92  
16.6 Downloading Video to your Computer Hard Drive .................... 93  
16.7 Alarm .................................................................................... 94  
16.8 Log........................................................................................ 95  
16.9 E-map .................................................................................. 96  
16.10 Devices ................................................................................ 98  
16.11 Device Config .......................................................................... 99  
16.12 Alarm CFG .............................................................................. 99  
16.13 Tour & Task ......................................................................... 102  
16.14 Account................................................................................ 103  
16.14.1 Managing User Accounts ............................................... 103  
16.14.2 Managing Roles ........................................................... 105  
16.15 General ................................................................................ 106  
16.15.1 Basic ......................................................................... 106  
16.15.2 File ........................................................................... 106  
16.15.3 Alarm Prompt .............................................................. 107  
16.15.4 Version ...................................................................... 108  
17 Connecting to your System Using Smartphone or Tablet Apps .......... 109  
17.1 FLIR Secure™ ....................................................................... 109
### Table of contents

17.1.1 Connect to Your Mobile Device Using FLIR Secure™ ........... 109
17.1.2 iPhone ........................................................................ 110
17.1.3 Android Phone ............................................................ 119

18 DDNS Setup (Advanced) .................................................................. 129
18.1 Accessing your System within a Local Network (LAN) ............... 129
18.1.1 Step 1 of 3: Connect your System to Your Router ................ 129
18.1.2 Step 2 of 3: Obtain the System's Local IP Address ............... 130
18.1.3 Step 3 of 3: Connect to the System's Local IP Address ............ 130
18.2 DDNS Setup—Access your System Remotely over the Internet ......................................................... 132
18.2.1 Step 1 of 4: Port Forwarding ........................................... 133
18.2.2 Step 2 of 4: Create a DDNS Account ................................ 133
18.2.3 Step 3 of 4: Enable DDNS on the System ......................... 137
18.2.4 Step 4 of 4: Connect to the System's DDNS Address ........... 137

19 Connecting a PTZ Camera (LNR600 Series) ........................................ 141
19.1 Controlling a PTZ Camera (Local NVR) ..................................... 141
19.2 Advanced PTZ Controls ........................................................... 142
19.2.1 Presets ...................................................................... 142
19.2.2 Tours ......................................................................... 143
19.2.3 Pattern....................................................................... 143
19.2.4 Auto Scan .................................................................. 144

20 LNR600 Series Hard Drive Installation................................................ 145
20.1 Installing a Hard Drive .............................................................. 145
20.2 Removing the Hard Drive........................................................... 146
20.3 Formatting Hard Drives ............................................................ 147

21 Recording Audio ............................................................................. 149
21.1 Step 1 of 2: Connecting an audio-capable camera ......................... 149
21.2 Step 2 of 2: Configuring audio recording ...................................... 150

22 Troubleshooting .............................................................................. 151

23 LNR600 Series System Specifications................................................ 153
23.1 System ................................................................................. 153
23.2 Inputs/Outputs ....................................................................... 153
23.3 Display ................................................................................. 153
23.4 Recording .............................................................................. 153
23.5 Playback and Backup .............................................................. 154
23.6 Storage & Archive ................................................................... 154
23.7 Connectivity .......................................................................... 154
23.8 General ................................................................................ 154
23.9 Recording Resolution (Pixels) & Maximum Speed (FPS — Frames per second) ................................. 155

24 Notices........................................................................................... 156
24.1 FCC/IC Notice........................................................................ 156
24.2 Modification .......................................................................... 156
24.3 ROHS ................................................................................ 156
In addition to the careful attention devoted to quality standards in the manufacturing process of your product, safety is a major factor in the design of every instrument. However, safety is your responsibility too. This sheet lists important information that will help to ensure your enjoyment and proper use of the product and accessory equipment. Please read them carefully before operating and using your product.

1.1 General Precautions

1. All warnings and instructions in this manual should be followed.
2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a water-dampened cloth for cleaning.
3. Do not use this product in humid or wet places.
4. Keep enough space around the product for ventilation. Slots and openings in the storage cabinet should not be blocked.
5. It is highly recommended to connect the product to a surge protector to protect from damage caused by electrical surges. It is also recommended to connect the product to an uninterruptible power supply (UPS), which has an internal battery that will keep the product running in the event of a power outage.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain electrical safety. Power line operated equipment or accessories connected to this product should bear the UL listing mark or CSA certification mark on the accessory itself and should not be modified so as to defeat the safety features. This will help avoid any potential hazard from electrical shock or fire. If in doubt, contact qualified service personnel.</td>
</tr>
</tbody>
</table>

1.2 Installation

1. Read and Follow Instructions - All the safety and operating instructions should be read before the product is operated. Follow all operating instructions.
2. Retain Instructions - The safety and operating instructions should be retained for future reference.
3. Heed Warnings - Comply with all warnings on the product and in the operating instructions.
4. Polarization - Do not defeat the safety purpose of the polarized or grounding-type plug.
   A polarized plug has two blades with one wider than the other.

![Polarized Plug Image]

A grounding type plug has two blades and a third grounding prong.

![Grounding Type Plug Image]

The wide blade or the third prong are provided for your safety.

If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
5. **Power Sources** - This product should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supplied to your location, consult your video dealer or local power company. For products intended to operate from battery power, or other sources, refer to the operating instructions.

6. **Overloading** - Do not overload wall outlets or extension cords as this can result in the risk of fire or electric shock. Overloaded AC outlets, extension cords, frayed power cords, damaged or cracked wire insulation, and broken plugs are dangerous. They may result in a shock or fire hazard. Periodically examine the cord, and if its appearance indicates damage or deteriorated insulation, have it replaced by your service technician.

7. **Power-Cord Protection** - Power supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords at plugs, convenience receptacles, and the point where they exit from the product.

8. **Surge Protectors** - It is highly recommended that the product be connected to a surge protector. Doing so will protect the product from damage caused by power surges. Surge protectors should bear the UL listing mark or CSA certification mark.

9. **Uninterruptible Power Supplies (UPS)** - Because this product is designed for continuous, 24/7 operation, it is recommended that you connect the product to an uninterruptible power supply. An uninterruptible power supply has an internal battery that will keep the product running in the event of a power outage. Uninterruptible power supplies should bear the UL listing mark or CSA certification mark.

10. **Ventilation** - Slots and openings in the case are provided for ventilation to ensure reliable operation of the product and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the product on a bed, sofa, rug, or other similar surface. This product should never be placed near or over a radiator or heat register. This product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is provided and the product manufacturer’s instructions have been followed.

11. **Attachments** - Do not use attachments unless recommended by the product manufacturer as they may cause a hazard.

12. **Water and Moisture** - Do not use this product near water — for example, near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement, near a swimming pool and the like.

13. **Heat** - The product should be situated away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.

14. **Accessories** - Do not place this product on an unstable cart, stand, tripod, or table. The product may fall, causing serious damage to the product. Use this product only with a cart, stand, tripod, bracket, or table recommended by the manufacturer or sold with the product. Any mounting of the product should follow the manufacturer’s instructions and use a mounting accessory recommended by the manufacturer.

15. **Camera Extension Cables** – Check the rating of your extension cable(s) to verify compliance with your local authority regulations prior to installation.

16. **Mounting** - The cameras provided with this system should be mounted only as instructed in this guide or the instructions that came with your cameras, using the provided mounting brackets.
17. **Camera Installation** - Cameras are not intended for submersion in water. Not all cameras can be installed outdoors. Check your camera environmental rating to confirm if they can be installed outdoors. When installing cameras outdoors, installation in a sheltered area is required.

### 1.3 Service

1. **Servicing** - Do not attempt to service this product yourself, as opening or removing covers may expose you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.

2. **Conditions Requiring Service** - Unplug this product from the wall outlet and refer servicing to qualified service personnel under the following conditions:
   - When the power supply cord or plug is damaged.
   - If liquid has been spilled or objects have fallen into the product.
   - If the product has been exposed to rain or water.
   - If the product has been dropped or the cabinet has been damaged
   - If the product does not operate normally by following the operating instructions. Adjust only those controls that are covered by the operating instructions. Improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the product to its normal operation.
   - When the product exhibits a distinct change in performance. This indicates a need for service.

3. **Replacement Parts** - When replacement parts are required, have the service technician verify that the replacements used have the same safety characteristics as the original parts. Use of replacements specified by the product manufacturer can prevent fire, electric shock, or other hazards.

4. **Safety Check** - Upon completion of any service or repairs to this product, ask the service technician to perform safety checks recommended by the manufacturer to determine that the product is in safe operating condition.

### 1.4 Use

1. **Cleaning** - Unplug the product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

2. **Product and Cart Combination** - When product is installed on a cart, product and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the product and cart combination to overturn.

3. **Object and Liquid Entry** - Never push objects of any kind into this product through openings as they may touch dangerous voltage points or "short-out" parts that could result in a fire or electric shock. Never spill liquid of any kind on the product.

4. **Lightning** - For added protection of this product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the product due to lightning and power line surges.
The system comes with the following components:

- NVR (Network Video Recorder)
- AC power cable
- Remote control (may not be exactly as shown)
- USB mouse
- Ethernet cable
- HDMI cable
- Quick start guides

Hard drive size, number of channels, and camera configuration may vary by model. Please refer to your package for specific details. Check your package to confirm that you have received the complete system, including all components shown above.
Front Panel (LNR600 Series)

1. **IR receiver and LED indicators**: IR receiver for the remote control. Keep the IR receiver clear from obstructions.
   - **Channel Indicators**: Glow when camera is connected to the corresponding channel.
   - **NET**: Glows when network is in normal state. Turns off for network error.
   - **HDD**: Glows to indicate hard drive is in normal state. Turns off when there is a hard drive error.
   - **PWR**: Glows to indicate the recorder is on.

2. **Playback buttons**:
   - **Previous file**: Press to skip to the previous video file on the system.
   - **Next file**: Press to skip to the next video file on the system.
   - **Slow**: Press to slow playback / decrease playback speed.
   - **Fast**: Press to speed up playback / increase playback speed.
   - **Play backwards**: Press to play video backwards / pause video.
   - **Play**: Press to play video / pause video.

3. **SHIFT**: During text input, press to switch input types.
4. **REC**: Press to open manual recording controls.
5. **FN**: Performs special functions in some menus.
6. **ESC**: In menus, press to go back / exit menus. In playback, press to return to live view.
7. **Directional buttons**:
   - **From live view, press once to open the System Information screen. In menus, press to confirm menu options.**
   - **Directional buttons**: Press to move cursor in menus. In live view, press up to change split screen layout; press left / right to select channels when single-channel mode is selected.
8. **USB port**: Connect a USB mouse (included) or connect a USB thumb drive (not included) for data backup or firmware upgrades.
9. **Power button**: Press and hold to power off the system (system password required). Press to power the system back on.
Rear Panel (LNR600 Series)

LNR608 (8-channel)

1. **Power input**: Connect the included AC power cable.
2. **On / Off switch**: Turns the NVR on or off.
3. **PoE Ports**: Connect IP cameras. Integrated PoE (Power Over Ethernet) ports provide power to cameras and video connection to NVR.
4. **LAN**: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.
5. **VGA**: Connect a VGA monitor (not included) to view the system interface.
6. **Audio IN/Audio OUT**: Service only; not supported.
7. **HDMI**: Connect to an HDMI monitor or TV (not included) to view the system interface.
8. **RS232**: Service only; not supported.
9. **USB port**: Connect a USB mouse (included) or connect a USB thumb drive (not included) for data backup or firmware upgrades.
10. **Alarm block**: Connect alarm/sensor devices (not included).

LNR616 (16-channel) / LNR632 (32-channel)

1. **Power input**: Connect the included AC power cable.
2. **On / Off switch**: Turns the NVR on or off.
3. **PoE Ports**: Connect IP cameras. Integrated PoE (Power Over Ethernet) ports provide power to cameras and video connection to NVR.
4. **Alarm block**: Connect alarm/sensor devices (not included).
5. **HDMI**: Connect to an HDMI monitor or TV (not included) to view the system interface.
6. **VGA**: Connect a VGA monitor (not included) to view the system interface.
7. **USB port**: Connect a USB mouse (included) or connect a USB thumb drive (not included) for data backup or firmware upgrades.
8. **RS232**: Service only; not supported.
9. **LAN**: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.
10. **Audio IN/Audio OUT**: Service only; not supported.
5.1 Step 1: Connect the IP Cameras

Option 1: Direct Connection to NVR
- Connect cameras to the PoE Ports on the rear panel of the NVR using Cat5e or higher grade Ethernet cable. The cameras will appear on the NVR without any additional configuration when the system starts up.

**NOTE**
Compatible with Lorex HD IP cameras. For a list of compatible cameras, please visit www.lorextechnology.com/support

Option 2: Connect Cameras to Local Network
You can also connect your IP cameras to your local network for flexible installations. For details, see 5.11 Connecting Cameras to the Local Area Network (LAN).

5.2 Step 2: Connect the Mouse
- Connect a USB mouse (included) to one of the USB ports.

5.3 Step 3: Connect the Ethernet Cable
- Connect an Ethernet cable (included) to the LAN port on the rear panel of the system. Connect the other end of the Ethernet cable to a router on your network.
5.4 Step 4: Connect the Monitor

- Connect the included HDMI cable from the HDMI port to the TV or monitor (recommended).
  OR
- Connect a VGA cable (not included) from the VGA port to the monitor.

1. VGA port.
2. HDMI port.

5.5 Step 5: Connect the Power Adapter to Power the NVR

- Connect the included AC power adapter to the NVR and connect the other end to a power outlet or surge protector. Then turn the power switch to I to power on the NVR.

At startup, the system performs a basic system check and runs an initial loading sequence. After a few moments, the system loads a live display view.

5.6 Step 6: Upgrade Firmware to Latest Version (if Available)

If a firmware upgrade is available, you will be asked to install it once the system starts up. It is required to upgrade your system firmware and client software or mobile apps to the latest version to enable remote connection to the system.
If a firmware upgrade is available:
1. After startup, a notification will appear asking you to upgrade the firmware. Click OK to upgrade.
2. Enter the system user name (default: admin) and password (default: 000000) and click OK. Wait for the firmware update to complete. The system will restart once the firmware has been upgraded.

**WARNING**
DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING Firmware INSTALLATION

5.7 Step 7: Verify Camera Image
• Power on the cameras, and then verify the camera video quality before mounting the cameras to a permanent location.
• Mount the cameras under a sheltered location. Always verify the outdoor rating of your camera before installing it in a permanent location.

5.8 Step 8: Set the Time
• Set the system time and date for accurate video time stamps. Videos with inaccurate times may not be valid as surveillance evidence.
• For details on setting the system time, see 9 Setting The Time, page 23.

5.9 Default System Password & Port Numbers

**CAUTION**
By default, the system user name is admin and the password is 000000. It is essential that you create your own password. For details, see 13 Managing Passwords and User Accounts, page 37.

The system requires a user name and password to log in to the system remotely using a computer. After logging on remotely the first time through FLIR Cloud™, you will be asked to create a custom password for the system.

**Local system and remote connectivity (LAN & Internet) user name and password:**
• Username: admin
• Password: 000000

**Default ports for DDNS remote access:**
• Port 80 (HTTP port)
• Port 35000 (Client port)

5.10 Quick Access to System Information
To quickly open a window that displays vital system information:
• Right-click to open the Quick Menu and click Info. Enter the system user name (default: admin) and password (default: 000000).
  OR
• Press the button on the front panel.
  OR
• Press the ENTER button on the remote control.
INFO Screen:

The QR code shown in the System Info screen can be scanned during mobile setup to enter the system’s Device ID.

5.11 Connecting Cameras to the Local Area Network (LAN)

For flexibility, you may also connect IP cameras to the same Local Area Network (LAN) as the NVR. This is accomplished by connecting the cameras to the same router as the NVR.

For these installations, an external PoE switch (sold separately) or power adapter (sold separately) must be used to provide power to each IP camera. You also must add the cameras on the NVR before they will show a picture on the monitor or be recorded by the NVR.

Follow the steps below to connect the cameras to the NVR over the LAN.

- Compatible with Lorex HD IP cameras. For a list of compatible cameras, please visit www.lorextechnology.com/support.
- Camera and NVR images in this section are used for illustration only.

Step 1 of 2 — Option A: Connecting cameras to your local network using a PoE switch:
1. Connect an Ethernet cable from the LAN port on an external PoE switch (sold separately on www.lorextechnology.com) to your router using a CAT5e or higher Ethernet cable. Connect the power cable to the PoE switch and to a power outlet or surge protector.

**NOTE**

Terminology may vary depending on the model of PoE switch you have.

2. Connect the IP cameras to the PoE switch using the Ethernet extension cables. The PoE switch will provide power and video transmission the same way as your NVR.

Step 1 of 2 — Option B: Connecting cameras to your local network using power adapters:

1. Connect each camera to a compatible power adapter (visit www.lorextechnology.com for compatible power adapters for your cameras).
2. Connect the camera to your router using a CAT5e or higher Ethernet cable.

Step 2 of 2: Add the cameras to your NVR:

1. Right-click and select **Device Search**.
2. Log in using the admin account (default User Name: *admin*; default password: *000000*).
3. Click **Device Search**. The system searches the network for compatible cameras.
4. Check the camera(s) you would like to add.
5. Click **Add**. The Status indicator turns green to show the camera is successfully connected.

6. Click **OK** to save changes.

**NOTE**

You can also add a camera to a specific channel by hovering the mouse over an empty channel in split-screen view and clicking 🖼️. Then double-click the camera you would like to add and right click to exit.
Mouse Control

The mouse is the primary control device for the system. To connect a USB mouse:

- Connect a USB mouse to the USB port on the front or rear panel.
- In live view, hover the mouse cursor over the bottom of the screen to open the Navigation Bar. Move the mouse cursor away from the bottom of the screen to close the navigation bar.

1. **Left-button**:
   - In live view, while in a split-screen display mode, click an individual channel to view it in full-screen. Click again to return to the split-screen display mode.
   - While navigating menus, click to open a menu option.

2. **Right-button**:
   - During live view, right-click anywhere on the screen to open the Quick Menu.
   - Within system menus, right-click to exit menus.

3. **Scroll wheel**: In live view, use the scroll wheel to zoom in/out.
1. **Power**: Press and hold to power off the system. Press to power on.

2. **Playback controls**:
   - **Pause/Play**: In live view, press to enter playback mode. Press to play/pause playback.
   - **Reverse**: Press to reverse playback/pause playback.
   - **Fast**: Press to increase playback speed.
   - **Next**: Press to skip to next video.
   - **Previous**: Press to skip to previous video.
   - **Slow**: Press for slow playback.

3. **Esc**: In menus, press to go back / exit menus. In playback, press to return to live view.

4. **Directional keys**:
   - **Enter**: Press once to open the System Information screen. Press to confirm menu selections.

5. **Mult**: Press to switch between full-screen and split-screen layouts.

6. **Number keys**:
   - **1~0**: In live view, press to open channels in full-screen.
   - In menus, press to input numbers or text input.
   - **Shift**: Press to change input types.

7. **Add**: Configure remote control address. See below for details.

8. **Rec**: Press to open manual record menu.

9. **Fn**: Press to perform special functions in some menus.
7.1 Setting the Remote Control Address

If you have more than one system, you can set up your remote control to pair with a specific system.

To set the remote control address:

1. Right-click and click Main Menu. Enter the system user name (default: admin) and password (default: 000000).

2. Click and then click Setting>General>General.

3. Under Device No., enter the address number you would like to assign to the remote control.

4. Click OK.

5. Using the remote control, press Add. Then enter the address number and press Enter.

**NOTE**

When entering the address number using the remote, make sure that you press three digits. A single-digit number should be preceded by two zeros. A two-digit number should be preceded by one zero. For example, if you entered 8 as the Device No., you have to press Add then 008 on the remote.
Use the system’s graphical on-screen display to navigate menus and configure options and settings.

8.1 On-Screen Display

The system shows the following for all display views:

1. **Display area:**
   - Click on a channel to view in full-screen; click again to return to split screen.
   - Right-click to open the Quick Menu.
   - Hover the mouse cursor over the bottom of the screen to open the Navigation Bar. Move the mouse cursor away from the bottom of the screen to close the navigation bar.
   - Move the mouse to the top of a channel to view the Camera Toolbar.
   - Click-and-drag cameras to rearrange the channel display. This does not affect the channels each camera is connected or recording to.

2. **Channel name**

3. **Camera is continuously recording.**

4. **Motion has been detected and video is recording.**

5. **Motion has been detected but video is not recording.**

6. **Date & time:** Current system date and time. For details on setting the date and time, see 9 Setting The Time, page 23.
8.2 Using the Quick Menu

The Quick menu gives you access to the system’s key functions. To access the Quick Menu, right-click the screen during live view.

The Quick Menu has the following options:

- **View**: Select a camera in full-screen or select a multi-channel display.
- **Pan/Tilt/Zoom**: Access controls for PTZ cameras (not included).
- **Fish Eye**: Access controls for Fish Eye cameras (not included).
- **AutoFocus**: Access zoom/focus controls for auto-focus cameras (not included).
- **Camera Setting**: Configure image settings for cameras.
- **Info**: Opens the system information window.
- **Sequence**: Click to start/stop sequence mode.
  
  In sequence mode, the system will automatically cycle through connected cameras every few seconds. A will appear to show that sequence mode is on.
  
  Click the icon to pause sequence mode on the channel that is currently shown (icon changes to ). Click again to resume sequence mode. Right-click and select Sequence to return to normal viewing mode.

- **Disable Beep**: Disable beeping alarms.
- **Search**: Search/playback recorded video. See 11 Search (Playback), page 26
- **Manual Control**: Click Record to open the Record menu to select manual recording options. See 10.3 Setting up Scheduled or Manual Recording, page 24. Click Alarm Output to control alarm output devices (not included).
- **Device Search**: Open the Device Search menu to manage IP cameras over the local network.
- **Main Menu**: Open the Main Menu. See 14 Using the Main Menu, page 41.

8.3 Adjusting Camera Image Settings

Use the Camera Setting menu to adjust image settings for your cameras.

**To adjust image settings:**

1. Right-click on the channel you would like to configure and select Camera Setting. Enter the system password if prompted.
2. Configure the following settings as needed:

- **Mirror**: Select **Enable** to flip the image horizontally.
- **Flip**: Select **Flip 180°** to flip the image vertically, or select **No Flip** for the default orientation. You can also select the options, **Clockwise 90°** or **Anticlockwise 90°**.
- **Corridor Mode**: Not supported.
- **3D NR**: Select **Enable** to turn on the camera's noise reduction feature. Noise reduction will ensure a cleaner image, especially at night, and may reduce the amount of disk space required to store video.
- **Backlight Mode**: Select one of the following:
  - **Backlight Mode**: Adjusts the lighting levels in the picture so you can see objects in the foreground if there is a strong light source behind them.
  - **WDR**: The camera compensates for changes in brightness across the image to enhance the picture quality of both light and dark areas.
  - **HLC**: The camera dims the brightest areas of the image to make them clearer.
  - **Off**: Disable this function.
- **Scene Mode**: This mode allows you to adjust white balance levels for the camera. Select **Auto** for the camera to automatically adjust the white balance. Select **Sunny** or **Night** to use preset white balance levels. Select **Customized** to manually set the blue and red levels.
- **Day&Night**: This setting sets the camera's day/night mode. Select **Color** for the camera to use color mode at all times. Select **Auto** for the camera to automatically determine whether to use color or black and white mode. Select **Black&White** for the camera to use black and white mode at all times.
  
  **NOTE** It is recommended to select **Auto** mode, as using **Color** mode may impact the camera's performance at night.

- **Saturation**: Adjust the vibrancy of colors in the image.
- **Brightness**: Adjust the image brightness.
- **Contrast**: Adjust the image contrast.
- **Hue**: Adjust the color hue of the image.
3. Click **OK** to save changes.

**NOTE**

You must save changes to apply settings changes. It is recommended to adjust one setting at a time so you can see the results of each change. Click **Default** to reset the camera to default image settings.

### 8.4 Using the Navigation Bar

The Navigation Bar gives quick access to certain functions and menus.

**To open the Navigation bar:**

- In live view, hover the mouse cursor over the bottom of the screen to open the Navigation Bar. Move the mouse cursor away from the bottom of the screen to close the navigation bar. The Navigation Bar has the following options:

1. **Main Menu.**
2. **Collapse.**
3. **Select display layout.**
4. **Sequence Control**: Click to start/stop sequence mode.
5. **PTZ**: Click to open PTZ controls.
6. **Camera**: Click to open camera image settings.
7. **Search**: Search and playback recorded video. See 16.4 *Playback*, page 90.
9. **Channel Info**: Click to access status information about connected cameras.
10. **Remote Device Search**: Manage IP cameras over the network.
11. **Network**: Configure network settings for your system. See 14.3.1 *Network*, page 53.
12. **HDD Manager**: Manage hard drives connected to the system. See 14.3.21 *Formatting the Hard Drive*, page 69.
13. **USB Manager**: Click to access options for connected USB thumb drives (not included). You can backup video, logs, or system configurations and install firmware upgrades.
14. **System Upgrade**: Check for firmware upgrades. The system must be connected to the Internet to check for or receive updates.

### 8.5 Using the Camera Toolbar

The Camera Toolbar is used to perform actions on a specific channel.

**To access the Camera Toolbar:**

- Move the mouse to the top of the channel display. The Camera Toolbar has the following options:
8.5.1 Using Instant Playback

Instant Playback is used to playback the last 5~60 minutes of video from the selected channel. You can also access Quick Playback in split-screen mode, while still viewing live video from the other channels.

To use Instant Playback:

1. Move your mouse to the top of the channel display and click.

   **NOTE**
   
   By default, the system will begin playback from 5 minutes ago. You can increase this to up to 60 minutes using the Instant Playback setting in Main Menu>Setting>General.

2. Right-click to exit Instant Playback.

8.5.2 Using Digital Zoom in Live Display

1. Move your mouse to the top of the channel display and click to activate digital zoom. A check mark will appear in the icon to indicate digital zoom is activated.

   **NOTE**
   
   You may activate digital zoom in multiple channels at the same time.

2. Click and drag inside the channel to zoom in.
   - Click and drag to pan the zoom area.
   - Right-click to zoom out and select a new zoom area.
   - Click to disable digital zoom. Note that the channel will remain at the same zoom level until you right-click inside it.

8.5.3 Using Real-time Backup

Real-time backup allows you to save footage from the live display to a USB thumb drive (not included) or external hard drive (not included).

To use Real-time Backup:

1. Insert the USB thumb drive or external hard drive into one of the USB ports on the system.
2. Move your mouse to the top of the channel display and click to start Real-time Backup.

3. Click again to end Real-time Backup. The file is saved to your USB device.

### NOTE

If the system prompts you to log in, you will need to click again to start Real-time Backup after logging in.

#### 8.6 Using the Virtual Keyboard

The Virtual Keyboard is used to input text or numeric values in certain menus.

1. **Backspace.**
2. **Enter capital letters.**
3. **Confirm entry.**

#### 8.7 Adjusting Camera Zoom & Focus

Auto-focus cameras (not included) have a motorized lens. The motorized lens allows you to control the zoom and focus settings using the menus on your system.

**To adjust the camera's zoom focus:**

1. Click on the channel where the motorized lens camera is connected.
2. Right-click and then click **AutoFocus**. Log into the system using the admin account (default user name is **admin** and password is **000000**).
3. Adjust the zoom and focus using the following options:
   - Use the sliders to adjust the **Zoom** or **Focus** settings for the camera.

   **NOTE**

   Hover the mouse over the sliders and use the mouse wheel to adjust by 1% at a time.

   - Click the **AutoFocus** button to automatically focus the camera at the current zoom level.
   - Click **Reset** to return the camera to the default zoom and focus levels.
• Click **Refresh** to refresh the settings shown on the system if someone has used the manual lens controls on the camera.

4. Right-click to exit and save changes.
CAUTION
It is highly recommended to set the date and time when first setting up your system. Inaccurate time stamps may render your footage unusable for court evidence.

To set the date and time:
1. In the main viewing mode, right-click and click **Main Menu**.
2. Log in using the system user name (default: **admin**) and password (default: **000000**).
3. Click **Setting** and select **Setting**. Click **General** and select the **Date&Time** tab.

![Setting Date and Time](image)

4. Under **System Time**, enter the current time and select your time zone. Then, click **OK**.
5. Check the **DST** check box to enable auto Daylight Savings Time updates.

   NOTE
   • You can adjust the **Start Time** and **End Time** for Daylights Savings Time if the default settings do not match your region.
   • Under **DST Type**, select **Week** to set the start and end time based on a day and week (e.g. 2nd Sunday in March), or select **Date** to set the start and end time to a specific date.

6. (Optional) Check the **NTP** check box to sync your system with an Internet time server. Click **Manual Update** to instantly update the time.

   NOTE
   • Your system must have a constant connection to the Internet to use NTP.
   • (Advanced) You can enter a custom NTP server under **Server** and **Port**, and you can select how often the system will sync the time using **Interval**.

7. Click **Apply** to save changes.
By default, the system is set to immediately record video from connected cameras continuously, 24 hours a day. You can customize the recording settings according to your needs.

10.1 Video Recording Types

The system supports the following recording types.

- **Recording—Continuous**: Normal, continuous recording. A 📣 icon is shown when recording is in progress.

- **Recording—Motion**: The system records when motion is detected by the camera. An 📸 icon is shown when motion is detected.

10.2 Main Stream and Sub Stream

The system employs two video recording streams, a Main Stream and a Sub Stream. Both Main Stream and Sub Stream recording are enabled by default.

The Main Stream records high quality video to your system's hard drive.

The Sub Stream records lower resolution video for efficient streaming to devices over the Internet. Sub Stream recording must be enabled to view video recordings on a computer or mobile device.

You can configure the video quality parameters for the Main Stream or Sub Stream. For details, see 14.1.6 Configuring Recording Quality, page 43.

10.3 Setting up Scheduled or Manual Recording

You can set the system to record based on a schedule or you can manually turn recording on and off. By default, the system is set to record on an always on recording schedule.

To configure the recording schedule, see 14.3.16 Configuring the Video Recording Schedule, page 64.

**To select between scheduled and manual recording:**

1. Right-click and then select **Manual Control>Record**.
2. Under **Main Stream**, select how the system will record the Main Stream for each channel.
   - **Auto**: Main Stream Recording will follow the recording schedule.
   - **Manual**: The system will record the Main Stream continuously as long as this option is checked.
   - **Off**: The system will not record the Main Stream for this channel. This option is not recommended.

3. Under **Sub Stream**, select how the system will record the Sub Stream for each channel.
   - **Auto**: Sub Stream Recording will follow the recording schedule.
   - **Manual**: The system will record the Sub Stream continuously as long as this option is checked.
   - **Off**: The system will not record the Sub Stream for this channel.

4. Under **Snapshot**, select **Enable** to enable snapshot recording on each channel. Or, select **Disable** to disable snapshot recording.

5. Click **OK** to save changes.

### 10.4 Configuring Hard Drive Overwrite

When the hard drive is full, the system will overwrite the oldest recordings by default. This is recommended, as it makes sure that your system will continue to record without any input from you. You can also set the system to stop recording once the hard drive is full.

**To configure hard drive overwrite:**

1. Right-click and select **Main Menu**. Click **Setting>General>General**.

2. Under **HDD Full**, select **Overwrite** for the system to overwrite the oldest recordings when the hard drive is full. Or, select **Stop Record** for the system to stop recording when the hard drive is full.

3. Click **OK** to save changes.
Search mode is used to navigate and playback recorded video files on the system.

11.1 Playing Back Video from the Hard Drive

1. From live view, right-click and then click Search.
2. Log in using the system user name (default: admin) and password (default: 000000).
3. Configure the following:

   3.1. Use the calendar on the right to select the day to playback.
   3.2. Use the drop-down menus to select the channels you would like to playback.
   3.3. Click inside the video bar to select the playback time. The system will begin playing back at the selected time.

   **NOTE**
   Click the display options ( ) to playback multiple channels simultaneously.
11.2 Playback Controls

1. **Select playback device.**
2. **Calendar:** Select the day to playback.
3. **Channel select:** Select channels to playback.
4. **Video clip backup:** Select video clip start and end times.
5. **Backup video clip:** Click to save selected clip.
6. **Playback Bar:** Click inside the bar to select a playback time.
7. **Zoom Playback Bar:** Select scope of time bar.
8. **Recording types:** Click to show/hide recording types.
9. **Speed up**
10. **Slow**
11. **Previous/next frame**
12. **Play backward**
13. **Stop**
14. **Play**

11.3 Playing Back from a USB Drive

If you have video files saved to a USB thumb drive (not included) or external hard drive (not included), you can play them back using the system.

**To play back from a USB drive:**

1. Connect the USB thumb drive (not included) or USB external hard drive (not included) with video files on it into a USB port on the system.
2. From live view, right-click and click **Search**.
3. Log in using the system user name (default: **admin**) and password (default: **000000**).
4. Click **From HDD** and select **From IO Device**. Click **Browse** to open the USB drive and manually select the video file.
5. Double click the video file you would like to open.

11.4 Using Smart Search

Smart Search makes it easy to review motion events in specific zones of your video stream. Select the areas that interest you and Smart Search plays your recording from the time when your camera detects motion in those areas. To set up smart search:

1. In the multiple-channel playback mode, click a channel and then click the Smart Search icon.
2. To create a Smart Search zone, left-click and select the area that you want to detect motion.
3. Repeat these steps for each channel that you want to use Smart Search.
4. Click to start the Smart Search playback. To stop the Smart Search playback, click again.
Backup video files to external USB thumb drive (not included) or self-powered USB external hard drive (not included).

**NOTE**

USB external hard drives (not included) must be formatted in the FAT32 file format to be used with the system.

### 12.1 Formatting the USB Thumb Drive

It is recommended to format your USB thumb drive (not included) before using it with the system.

**CAUTION**

Formatting the USB device will permanently erase all data.

**To format a USB device:**

1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then select *Main Menu*. Login if prompted.
3. Click > Backup.
4. Click *Browse*.
5. Click *Format*. Click *OK* to confirm.
12.2 Backing up Video

1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then select **Main Menu**. Login if prompted.
3. Click **Backup**.
4. Configure your search options:

   - **Type**: Select the recording type you would like to search for or select **All** to search all recording types. Also, select the video recording stream, choose either **Main Stream** or **Sub Stream**.
   - **Record CH**: Select the channel you would like to search or select **All** to search all channels.
   - **File Format**: Select **DAV** to save files to .dav format. You can use the Video Player from [www.lorextechnology.com/support](http://www.lorextechnology.com/support) to playback .dav files on PC or Mac. Or, select **ASF** for .asf format. You can playback .asf files in VLC Media Player (free download from [www.videolan.org](http://www.videolan.org)) on PC or Mac.

   **NOTE**

   VLC Media Player is a free software available from [www.videolan.org](http://www.videolan.org). VLC Media Player is not supported by Lorex.

   - **Start Time/End Time**: Select the start and end time for your search.
5. Click **Add**. A list of files that match your search criteria appears.
6. Check files you would like to backup and then click **Start**. Wait for the backup to complete.

   **NOTE**

   HD video files saved on the system may take up a large amount of disk space. The size of video files selected and the amount of free space on your USB device is shown at the top of the screen.

12.3 Using Video Clip Backup

Video clip backup allows you to select a duration of video during playback mode and save it to a USB device (not included).

**To use Video Clip Backup:**

1. Insert a USB thumb drive (not included) or USB external hard drive (not included) into one of the USB ports.

3. Click \[\text{Mark Clip Begin/End}\] to mark the beginning of the video clip. Click again to mark the end of the video clip.

4. Click \[\text{Backup Menu}\] to open the Backup menu.

5. Configure the following:

5.1. Check the USB device where you would like to save the file.

5.2. Check the files you would like to back up.

**NOTE**

Check the Combine Video check box to combine playback videos into a single playback file.

5.3. Click Backup then click Start. Wait for the backup to complete before removing the USB thumb drive.

12.4 Viewing Backup Files

To playback .dav backup video files, a Player is available for PC and Mac at www.lorextechnology.com/support. The PC version of the player is automatically saved to your USB device (not included) when you create a backup file.

12.4.1 Viewing Backup Files on PC

You need a video player to play back .dav backup video files. To find the video player visit www.lorextechnology.com, search for the model number of your product, click on your product in the search results, and click on the Downloads tab.
To view backup video files using the Player on PC:


2. Click to open a backup video file.

3. Use the Player controls to control playback or select other files for playback.

**Video Player Controls**

1. **File List**: Double-click to open a file.
2. **Display Area**: Select the split-screen mode. Double-click a video file to expand. Click the controls inside the display area to do the following:

- ![Information](image.png): View information about the video file.
- ![Record](image.png): Start/stop a manual recording from the video file.
- ![Snapshot](image.png): Take a snapshot from the video file.
- ![Close](image.png): Close the video file.

3. **Hide/show file list**.

4. **Playback controls**:

- ![Sequence](image.png): Playback files in sequence.
- ![Synchronize](image.png): Synchronize playback times.
- ![Playback](image.png): Play/pause playback.
- ![Stop](image.png): Stop playback.
- ![Previous](image.png): Previous frame.
- ![Next](image.png): Next frame.
- ![Speed](image.png): Playback speed.
- ![Volume](image.png): Volume control.

5. **Zoom Timeline**.

6. **Add Files**: Click to open backup video files.

7. **Digital Zoom**: Click to activate digital zoom mode. Click and drag in the video to zoom in. Right-click to unzoom.

8. **Drag**: When digital zoom is activated, click to activate drag mode. Then click and drag in the video to view different areas of the image.

9. **Full-screen**: Click to open the player in full screen. Press **ESC** to exit full screen.
10. **Config**: Click to open the configuration menu for the player. From here you can control the default file formats and save locations for snapshots and video files saved from the player.

![Smart Player Configuration Menu](image)

### 12.4.2 Viewing Backup Files on Mac

You need a video player to play back .dav backup video files. To find the video player visit [www.lorextechnology.com](http://www.lorextechnology.com), search for the model number of your product, click on your product in the search results, and click on the **Downloads** tab.

**To view backup video files using the Player on Mac:**

1. Download **Video Player for Mac** from [www.lorextechnology.com](http://www.lorextechnology.com).
2. Double click the downloaded file in Safari to extract the Smart Player app file.

![Safari Downloads](image)

3. Drag the **Smart Player** app to your Desktop or Applications list. Double click **Smart Player** to open it.
4. Click to open a back up video file in another location.

5. Use the Player controls to control playback or select other files for playback.

**Video Player Controls**

1. **File List**: Double-click to open a file.
2. **Display Area**: Select the split-screen mode. Double-click a video file to expand. Click the controls inside the display area to do the following:
   - View information about the video file.
   - Take a snapshot from the video file.
   - Close the video file.
3. **Hide/show file list.**

4. **Playback controls:**
   - ![Repeat](image1.png): When a video file ends, this button lets you select if you want the video player to repeat the same file or play the next file.
   - ![Play/Pause](image2.png): Play/pause playback.
   - ![Stop](image3.png): Stop playback.
   - ![Previous](image4.png): Previous file.
   - ![Next](image5.png): Next file.
   - ![Speed](image6.png): Playback speed.
   - ![Volume](image7.png): Volume control.

5. **Zoom Timeline.**
6. **Add Files:** Click to open backup video files.
7. **Full-screen:** Click to open the player in full screen. Press **ESC** to exit full screen.
8. **Config:** Click to open the configuration menu for the player. From here you can control the default file formats and save locations for snapshots and control the aspect ratio.

9. **About:** Click to see version information for the Player software.
Managing Passwords and User Accounts

By default, the system user name is **admin** and the password is **000000**. Passwords are enabled by default and are required to access the Main Menu or connect to the system using a computer or mobile device.

**NOTE**

If you forget the password to the system, contact technical support to have it reset.

The system includes the following default accounts:

- **admin**: The admin account has full access to the system, may configure all system settings, and can manage user accounts.

For security reasons, it is essential that you change the password on your system. **By default, the system password is enabled.**

### 13.1 Changing Passwords

You can change the system password of the admin and user accounts from the Users menu.

**To modify an account password:**

1. From Live View, right-click and then select **Main Menu**.
2. If prompted, enter the system user name (default: **admin**) and password (default: **000000**).
3. Click and select **Setting**. Select **Account**.
4. Click next to the user account you would like to modify.
5. Check **Modify Password**.
6. Under **Old Password**, enter the account's previous password.
7. Under **New Password**, enter a new 6 character password for the account. Repeat the new password under **Confirm Password**.
8. Click **OK** to save changes.

### 13.2 Adding Users

You can allow multiple users to log in to the system. When adding different users, you can assign what menus they have access to. For example, you may want your friend to monitor your system while you are away, while not giving full access to your system.

**To add a user account:**
1. From Live View, right-click and then select **Main Menu**.
2. If prompted, enter the system user name (default: *admin*) and password (default: *000000*).
3. Click and select **Setting**. Select **Account**.
4. Click **Add User**.
5. Configure the following:
   - **Username**: Enter a name for the user account.
   - **Password**: Enter a 6 character password for the user account. Enter the password again under **Confirm Password**.
   - **Memo (optional)**: Enter a description of the user account.
   - **Group**: Select the group you would like to assign to this user account. A user account cannot be given permissions its group does not have.
   - Under the **System** tab, select the menus the user account may access. Under the **Playback** tab, select which channels the user account may access recorded video from. Under the **Covert** tab, select the channels the user account may view live video from.
6. Click **OK** to save changes.

Now, you can log in to the system locally, or remotely using the user name and password you created. When logging into the system with a user account, the user will only have access to the menus you assigned.

### 13.3 Modifying Users

1. In the Account menu, click next to the user account you would like to modify.
2. Update the user's account details as needed, and then click **OK** to save changes.

### 13.4 Deleting Users

1. In the Account menu, click next to the user account you would like to delete.
2. Click **OK** to confirm.

**NOTE**
The admin account cannot be deleted from the system.
13.5 Account Groups

Account groups can be used to easily manage permissions for multiple user accounts. User accounts can be given all the permissions of a group, but cannot be given permissions that the group does not have.

The system includes the following groups by default:

- **admin**: Accounts in the admin group are system administrators. They have full access to the system, may configure all system settings, and can manage user accounts.
- **user**: Accounts in the user group are normal users. They have limited access to system menus.

13.6 Adding Groups

1. From Live View, right-click and then select **Main Menu**.
2. If prompted, enter the system user name (default: **admin**) and password (default: **000000**).
3. Click **Setting** and select **Setting**.
4. Click **Account** and select the **Group** tab.
5. Click **Add Group**.

6. Configure the following:

   - Under **Group Name**, enter a name for the group.
   - Under **Memo**, enter an optional comment for this group.
   - Under the **System** tab, select the menus the new group may access. Under the **Playback** tab, select which channels the new group may access recorded video from. Under the **Covert** tab, select the channels the new group may view live video from.
7. Click **OK** to save changes.

### 13.7 Modifying Groups

1. In the Group tab, click next to the group you would like to modify.
2. Update the group's details as needed, and then click **OK** to save changes.

### 13.8 Deleting Groups

1. In the Account menu, click next to the user account you would like to delete.
2. Click **OK** to confirm.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The admin and user groups cannot be deleted from the system.</td>
</tr>
</tbody>
</table>
Using the Main Menu

To open the Main Menu:

- **Using the Mouse**: Right-click and click **Main Menu**.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system password may be required to access the Main Menu. By default the user name is <strong>admin</strong> and the password is <strong>000000</strong>.</td>
</tr>
</tbody>
</table>

1. **SEARCH**: Open Search/Playback mode. For details, see 11 Search (Playback), page 26.
2. **BACKUP**: Export files to USB device. For details, see 12 Backup, page 29.
3. **CAMERA**: Open the menu to manage IP cameras connected to the network (see 5.11 Connecting Cameras to the Local Area Network (LAN), page 10 for details), set recording parameters, and assign custom titles for your cameras.
4. **INFO**: View system information.
5. **SETTING**: Configure general system, schedule, network, recording, display, and motion settings. Restore system to factory defaults.
6. **SHUTDOWN**: Logout, restart, or shutdown the system.

### 14.1 Camera

Open the Remote Device menu to manage IP cameras, set recording parameters, and assign custom titles for your cameras.

#### 14.1.1 Remote Device

The Remote Device menus allow you to add cameras over the local area network (LAN), configure camera image settings, view camera status, and upgrade camera firmware.

- See 5.11 Connecting Cameras to the Local Area Network (LAN) for instructions on connecting cameras to the NVR over the network.
- See 8.3 Adjusting Camera Image Settings, page 17 for details on setting up camera image settings.
14.1.2 Viewing Camera Status
The Camera Status menu allows you to view the connection and alarm status for all connected cameras.

To view camera status:
1. From the Main Menu, click and select Remote Device> Status.

14.1.3 Viewing Camera Firmware Versions
You can use the Firmware menu to view firmware versions for connected cameras.

To view camera firmware versions:
1. From the Main Menu, click and select Remote Device> Firmware.

14.1.4 Upgrading Camera Firmware
You can update the firmware for connected IP cameras through the NVR. Firmware upgrades provide enhanced functionality for the cameras. Lorex provides firmware upgrades for free from www.lorextechnology.com/support.

To upgrade the camera firmware:
1. Download the camera firmware from www.lorextechnology.com/support if one is available.

   NOTE
   Make sure that the firmware file you are using is compatible with your IP camera model.

2. Extract the firmware file and copy it to a USB thumb drive (not included).
3. Insert the USB thumb drive (not included) into a USB port on the system.

4. Right-click and select **Main Menu**. Click and select **Remote Device> IPC Upgrade**.

5. Click **Select**. Select the firmware file on the USB drive and click **OK**.

6. Check the cameras you would like to apply the upgrade to in the list and then click **Start Upgrade**.

```
CAUTION
Wait for the firmware upgrade to complete before turning off or unplugging the cameras or NVR. The cameras will restart during the firmware update process.
```

### 14.1.5 Recording

The Recording menu allows you to set recording parameters for your cameras, such as the resolution and frame rate.

### 14.1.6 Configuring Recording Quality

The system employs two video recording streams, a Main Stream and a Sub Stream. The Main Stream records high quality video to your system's hard drive. The Sub Stream records lower resolution video for efficient streaming to devices over the Internet. You can customize the video quality settings for these streams according to your needs.
NOTE

For select cameras, you can configure the live video stream to **Display Stream**. You can view display stream only in multiple channel live view. It is recommended to set the resolution to **704x480(D1)**.

To configure recording quality:

1. From the Main Menu, click ▪ and select **Recording>Recording**.
2. Under **Channel**, select the camera you would like to configure.
3. Under **Type**, select the recording type you want to configure the recording quality settings for.
4. Configure the following settings. Settings for the Main Stream are in the left column. Settings for the Sub Stream are in the right column.

**NOTE**

For select cameras, you can configure settings for display stream on the right column.

- **Compression**: Select the video compression type that will be used. It is recommended to select H.264, as it will have the best performance and use the least amount of disk space.

- **Resolution**: Select the resolution that you want to use to record the selected channel. Higher resolutions create a more detailed image, but take up more hard drive space to record and require more bandwidth to stream to connected computers or mobile devices.

**NOTE**

Available resolutions for the Main Stream and Sub Stream depend on the model of camera that is connected to the system.

- **Frame Rate (FPS)**: Select the frame rate in Frames Per Second (FPS) that each stream will record at. A higher frame rate provides a smoother picture, but requires more storage and bandwidth.

- **Bit Rate Type**: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate) to determine the bit rate type. If you select VBR, select the **Quality** from 1 (lowest) to 6 (highest).

- **Bit Rate (Kbps)**: Select the bit rate for each recording stream. A higher bit rate results in a better image, but increases the amount of hard drive space or bandwidth required.

**NOTE**

Only select cameras support the Audio/Video setting.

5. (Optional) Click the **Copy** button to copy recording settings to other channels.

6. Click **OK** to save changes.

### 14.1.7 Configuring Snapshot Recording Settings

The system can be set to record snapshot images when a camera detects motion. These snapshots can be viewed through the Search menu or can be attached to email alerts and push notifications. The Snapshot tab in the Recording menu controls the quality and recording parameters for each camera.
Using the Main Menu

NOTE

In order to enable Snapshot recording, the following menu options must be configured:

- The Snapshot schedule must be enabled for times that you would like to save snapshots. See 14.3.18 Configuring the Snapshot Schedule, page 66.
- Snapshot recording must be enabled for motion detection in the Event menu. See 14.3.8 Configuring Motion Detection, page 57.

To configure snapshot recording settings:

1. From the Main Menu, click [Recording] and select [Snapshot].
2. Under [Snapshot], select the number of snapshots the system will take when the snapshot button is pressed.
3. Configure the following settings for snapshots saved automatically from motion detection or the snapshot schedule:
   - **Snapshot**: Select the number of snapshots (up to 5) the system will take each time.
   - **Channel**: Select the channel you would like to configure.
   - **Mode**: Select **Timing** for the system to take snapshots according to the snapshot schedule (see 14.3.18 Configuring the Snapshot Schedule, page 66) Select **Trigger** for the system to take snapshots only when triggered by motion detection (snapshot must be enabled in the Motion Detect menu; see 14.3.8 Configuring Motion Detection, page 57).
   - **Image Size**: The image size is the same as the Main Stream resolution of the camera.
   - **Image Quality**: Select the snapshot image quality between 1 (lowest) and 6 (highest)
4. Click **OK** to save changes.

14.1.8 Configuring Video Overlay Settings

The Overlay tab allows you to configure the text and information that appears overtop of the camera image, such as time and channel display.

To configure video overlay settings:

1. From the Main Menu, click [Recording] and select [Overlay].
2. Under **Channel**, select the camera you would like to configure.
3. Configure the following settings:

- **Time Display**: Check this option to display the time information. Click **Set** next to **Time Display** to choose the position of the time display overlay. A live view screen of the currently-selected channel appears. Click and drag the time display to position it in any desired area. Right-click to exit the live screen.

- **Channel Display**: Check this option to display the channel information. Click **Set** next to **Channel Display** to choose the position of the channel display overlay. A live view screen of the currently-selected channel appears. Click and drag the channel display to position it in any desired area. Right-click to exit the live screen.

- **Cover-Area**: Check this option to hide certain parts of the camera image in video recordings. The numbered boxes under the **Cover-Area** check-box signifies the number of black boxes (masks) you want over your camera image. Select the desired number of boxes (you can configure up to four boxes). Click **Set** next to **Cover-Area** to choose the position of the mask overlay. You can also re-size the black boxes. Right-click to exit the live screen.

  **NOTE**
  Privacy masks block out parts of the camera image entirely and appear as black boxes in recordings.

- **Customized Title**: Check this option to display customized text. Under **Customized Title 1**, enter a custom text. You can add up to 5 lines of customized text. Under **Align Mode**, choose either **Left Align** or **Right Align**. Click **Set** next to **Customized Title** to choose the position of the customized text. Right-click to exit the live screen.

4. (Optional) Click the **Copy** button to copy overlay settings to other channels.
5. Click **OK** to save changes.

### 14.1.9 Creating Custom Channel Names

You can assign custom names to your cameras. For example, you can name your cameras based on their location (e.g. hallway or front door).

**To create custom channel names:**

1. From the Main Menu, click **Settings** and select **Channel Name**.
2. Enter a custom name for each channel.

3. Click **OK** to save changes.

### 14.2 Info

Info contains menus that show you system information.

### 14.2.1 HDD Info

The HDD Info sub-menu shows information related to the hard drives installed in the system, including capacity, status, and type.

**To access the HDD Info menu:**

- From the Main Menu, click ![Main Menu](image) and then click **Info>HDD Info**.
14.2.2 Record Info

The Record Info menu shows the start and end times of recordings saved on the hard drive.

To access the Record Info menu:

• From the Main Menu, click \[\text{Info} > \text{Record Info}\].

14.2.3 Version

The Version sub-menu allows you to view information about the current firmware installed on the system.

To access the Version menu:

• From the Main Menu, click \[\text{Info} > \text{Version}\].
14.2.4 Event Info

The Event Info menu shows you a display of system alarms. Activated alarms are highlighted in white. Additional info such as channels that are currently detecting motion is shown.

The following alarms are shown in the Alarm Status menu:

- **No HDD**: No hard drive is detected.
- **Disk Error**: Hard drive error detected.
- **Disk Full**: Hard drive is full.
- **IP Conflict**: More than one device on the network is using the same IP address.
- **Net Conflict**: System is not connected to the network.
- **MAC Conflict**: More than one device on the network is using the same MAC address.
- **External Alarm**: Sensor/alarm device (not included) has been triggered.
- **Video Loss**: Shows disconnected channels.
- **Tampering**: Camera tampering alarm has been triggered (e.g. someone has tampered with the camera)
- **Motion Detect**: Shows channels with active motion alarms.

To access the Event Info menu:

- From the Main Menu, click \( \text{Event} \) and then select \( \text{Event} \).

14.2.5 Online Users

The Online Users menu shows a list of users connected to the system using computers or mobile devices.

To access Online Users:

- From the Main Menu, click \( \text{Network} \) and then select \( \text{Network} \).
14.2.6 Load

The Load menu shows you the network traffic your system is sending and receiving.

To access Load:

- From the Main Menu, click and then select Network>Load.

14.2.7 Test

The Test menu allows you to test if your system can connect to other devices over the LAN or Internet. You can enter the IP address of a device and click Test to determine if your system can connect to it.

To access Test:

- From the Main Menu, click and then select Network>Test.

14.2.8 BPS

The BPS sub-menu shows the bitrates of connected cameras. The bitrate is the amount of data the camera is sending to the system.
To access BPS:

- From the Main Menu, click and then select BPS.

14.2.9 Log

The Log sub-menu allows you to search for system logs.

To search for system logs:

1. From the Main Menu, click and then select Log.
2. Under Type, select the log type to search for.
3. Under Start Time and End Time, select the start and end time for your search.
4. Click Search.
5. (Optional) Click Backup to export logs to a USB thumb drive connected to the system.

14.3 Setting

The Setting menu allows you to configure general system, schedule, network, recording, display, and motion settings. It also allows you to restore the system to factory defaults.
14.3.1 Network

The Network menu allows you to configure network parameters for your system.

14.3.2 Selecting DHCP or Static IP Address (TCP/IP)

The TCP/IP menu allows you to configure IP address settings.

To configure IP address settings:

1. From the Main Menu, click \[ \text{Network} \rightarrow \text{TCP/IP} \].
2. Check \text{DHCP} (recommended) to let the system automatically obtain an IP address from the router or uncheck to assign a static IP address.

If you uncheck DHCP, configure the following:

- **IP Address**: Enter the IP address you would like to assign to the system. Make sure that no other device on your network is using the same IP address.
- **Subnet Mask**: Enter the subnet mask for your network.
- **Default Gateway**: Enter the gateway address for your network.
- **Preferred DNS**: Enter the address of your primary DNS server.
- **Alternate DNS**: Enter the address of your secondary DNS server.

3. Click \text{OK} to save changes.

14.3.3 Configuring System Ports (Connection)

The Connection menu allows you to configure ports used by the system.

If you are using DDNS connectivity, port forwarding is required for the HTTP Port (default: 80) and TCP (Client Port) (default: 35000).

To configure system ports:
1. From the Main Menu, click and then select **Network>Connection**.

![Network Connection Menu](image)

2. Configure the ports as needed and click **OK** to save changes.

   **NOTE**
   Up to 3 devices may connect to the system at the same time.

### 14.3.4 Configuring DDNS Settings

Lorex DDNS is available as an optional connectivity option. Please see 18 **DDNS Setup (Advanced)**, page 129 for details.

The primary connectivity option uses FLIR Cloud™ to connect to your system over the Internet without requiring port forwarding or DDNS registration. For details, see 15 **Connecting to Your System Over the Internet on PC or Mac**, page 78.

**To configure DDNS Settings:**

1. Visit [http://www.lorexddns.net](http://www.lorexddns.net) and register for a DDNS account.

2. From the Main Menu, click and then select **Network>DDNS**.

![DDNS Configuration](image)

3. Check **Enable**.
4. Under **Domain Name**, enter the Domain Name/URL Request your received in the email after registering for DDNS.
5. Under **User ID**, enter your DDNS User Name.
6. Under **Password**, enter your DDNS Device password.
7. Click OK to save your settings.

NOTE
Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before attempting to connect.

14.3.5 Configuring Email Alerts
You can configure the system to send out email alerts for motion detection or other events.

NOTE
To send out motion detection alerts, you must enable the Send Email option for motion detection on each camera you would to receive alerts from. For details, see 14.3.8 Configuring Motion Detection, page 57.

To configure Email Alerts:

1. From the Main Menu, click and then select Network>Email.

2. Check Enable to enable email notifications.

If you want to use Lorex’s email server (recommended):

1. Under Mail Select, select Lorex Mail to use the Lorex email server to send out alarm notifications. This is the recommended setting.

2. Configure the following:
   - Email Schedule: Configure time periods during which email alerts will be sent.
   - Receiver: Enter the email address that will receive alerts.
   - Sender: Enter the sender’s email address.
   - Subject: Enter the subject line for the email alert.
   - Attachment: Check to include a jpg image attachment of the camera.

NOTE
You must enable the Snapshot option for motion detection on each camera you would to receive attachments. For details, see 14.3.8 Configuring Motion Detection, page 57.

3. Click Test to send a test email.
4. Click OK to save settings.

**If you want to use your own email server (advanced):**

1. Configure the following:
   - **SMTP Server**: Enter the SMTP server address.
   - **Port**: Enter the port used by the SMTP server.
   - **Anonymous**: Check if your server supports anonymous log ins. Otherwise, leave this unchecked.
   - **User**: Enter the SMTP user name.
   - **Password**: Enter the SMTP password.
   - **Receiver**: Enter the email address that will receive alerts.
   - **Sender**: Enter the sender's email address.
   - **Subject**: Enter the subject line for the email alert.
   - **Attachment**: Check to include a jpg image attachment of the camera.

   ![NOTE]
   You must enable the Snapshot option for motion detection on each camera you would to receive attachments. For details, see 14.3.8 Configuring Motion Detection, page 57.

   - **Encrypt Type**: Select SSL or TLS if your server uses encryption. Select None if your server does not use encryption.
   - **Interval**: Enter the interval between alert emails.
   - **Health Enable**: Check to enable health check emails. Health check emails will be sent periodically to ensure that the system is functioning normally. Also, enter the interval in minutes for health check emails.

2. Click Test to send a test email.
3. Click OK to save settings.

**14.3.6 Configuring Switch Settings (Advanced)**

You can configure the networking settings for the internal PoE switch.

![CAUTION]
It is recommended to leave this menu on the default settings. Changing the information in this menu may disrupt the connection to the cameras.

**To configure switch settings:**

1. From live view, right-click and select Main Menu.

2. Click Network>Switch .
3. Configure the IP Address, Subnet Mask, and Default Gateway for the internal PoE switch.

4. Click OK. Click Save to save changes. The system will restart.

### 14.3.7 Event

The Event menu allows you to configure settings for motion detection, video loss, and system warnings.

### 14.3.8 Configuring Motion Detection

Motion Detection events allow the system to mark footage that has motion. This allows you to quickly locate relevant footage through Search. You can also configure system responses to motion detection events, such as activating the system buzzer or sending an email alert.

**To configure Motion Detection events:**

1. From the Main Menu, click [Event](#) and then click **Event>Motion>Motion Detect**.

2. Under **Channel**, select the channel you would like to configure.

3. Check **Enable** to enable motion detection on the selected channel.
4. Click **Set** next to Region to configure which areas of the image will be enabled for motion detection. A grid will appear over the camera’s live view.

**Motion Grid**

- Areas enabled for motion detection are shown in color and areas that are disabled are transparent.
- Hover the mouse at the top of the screen to select which motion area you would like to configure. You can set up to 4 motion detection areas and customize the sensitivity and threshold for motion detection separately for each area between 0 (lowest) and 100 (highest).
- The **Sensitivity** determines how sensitive the camera is to motion. For example, if the sensitivity is high, small amounts of motion are more likely to trigger an event. It is recommended to select a Sensitivity between 30–70.
- The **Threshold** determines how much motion is required to trigger an event. If the amount of motion exceeds the threshold, an event occurs. It is recommended to select a Threshold between 10–50.
- Right-click when finished.

**NOTE**

It is recommended to have a second person walk in front of the camera to test different Sensitivity and Threshold settings to determine the best setting for your camera’s location.

5. Under **Anti-dither**, enter the anti-dither time. After a motion event occurs and motion stops, if motion is detected within the anti-dither time, the system continues the motion event and includes the new motion within the first event, rather than creating a new motion event.

6. Under **Post_REC**, enter the time the system will record after a motion event occurs.

7. To configure a schedule when motion detection will be enabled on this channel, click **Setup** next to **Period**. Configure times when motion detection will be enabled. For example, you may want to disable motion detection during business hours and enable it outside of business hours. Click **OK** when finished.

**NOTE**

This setting can override scheduled motion recording. This means that motion recording will only take place at times that are enabled both in the Schedule menu and here.
8. Configure the following system actions when motion is detected:

- **Alarm Out**: Check the box to activate alarm output devices (not included) when the selected channel detects motion. Select the alarm output devices will be activated when motion is detected.
- **Latch**: Enter the number of seconds an alarm output device will activate after motion is detected.
- **Show Message**: Check to enable an on-screen pop-up when one of your cameras detects motion. On-screen pop-up shows the channels an event occurred on and the type of event.
- **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
- **Channels**: Select the channels that will record when motion is detected on the selected channel.
- **PTZ Activation**: Check to enable PTZ actions when motion is detected (PTZ camera required; not included). Click **Setup** to select which PTZ actions will be taken by each camera.
- **Sequence**: Check to enable a custom sequence mode when motion is detected on the selected channel. Then click the channels you would like to display in the custom sequence mode.
- **Snapshot**: Check to save a snapshot when the camera detects motion.
- **Log Enable**: Check to activate log.
- **Buzzer**: Check to enable the system buzzer.

9. Click **OK** to save changes.

### 14.3.9 Configuring Video Loss Settings

Video Loss occurs if the system loses connection to one of the cameras.

**To configure Video Loss settings:**

1. From the Main Menu, click and then click **Event>Motion>Video Loss**.

2. Under **Channel**, select the channel you would like to configure.

3. Check **Enable** to enable video loss events for the selected channel.
4. Configure the following to customize settings for video loss events:
   - **Period**: Click **Setup** to configure a schedule for video loss events. It is recommended to leave this on the default setting, so you can be alerted at any time one of your cameras loses video.
   - **Alarm Out**: Select the alarm output devices (not included) that will trigger when video loss occurs.
   - **Latch**: Enter the number of seconds an alarm output device will activate after video loss occurs.
   - **Show Message**: Check to show a popup message on the monitor if one of your cameras loses video.
   - **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 14.3.5 *Configuring Email Alerts*, page 55).
   - **Channels**: Click the checkbox to enable video recording when video loss occurs. You can then select the channels the system will record when video loss occurs on the currently selected channel.
   - **PTZ Activation**: Check to enable PTZ actions when video loss occurs (PTZ camera required; not included). Click **Setup** to select which PTZ actions will be taken by each camera.
   - **Post_REC**: Enter the number of seconds the system will record after video loss occurs.
   - **Sequence**: Check to enable a custom sequence mode when motion is detected on the selected channel. Then click the channels you would like to display in the custom sequence mode.
   - **Snapshot**: Click the box to enable snapshot recording when video loss occurs. You can then select which channels will save snapshots when video loss occurs on the currently selected channel.
   - **Log Enable**: Check to activate log.
   - **Buzzer**: Check to enable the system buzzer when video loss occurs on the currently selected channel.

5. Click **OK** to save changes.

### 14.3.10 Configuring Tampering Settings

Allows you to set up your camera to detect video tamper and trigger alerts.

**To configure Video tamper alarm settings:**

1. From the Main Menu, click and then click **Event>Motion>Tampering**.  

   ![Tampering Settings Menu](image)

2. Under **Channel**, select the channel you would like to configure.
3. Check **Enable** to enable video tamper alarm for the selected channel.
4. Configure the following to customize settings for video loss events:
   - **Period**: Click Setup to configure a schedule when video tamper alarm will be activated. It is recommended to leave this on the default setting, so you will be alerted any time one of your cameras is tampered with.
   - **Alarm Out**: Select the alarm output devices (not included) that will trigger when video tamper occurs.
   - **Latch**: Enter the number of seconds an alarm output device will activate after video tamper occurs.
   - **Show Message**: Check to show a popup message on the monitor if one of your cameras is tampered with.
   - **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
   - **Channels**: Click the checkbox to enable video recording when video tamper occurs. You can then select the channels the system will record when video tamper occurs on the currently selected channel.
   - **PTZ Activation**: Check to enable PTZ actions when video tamper occurs (PTZ camera required; not included). Click Setup to select which PTZ actions will be taken by each camera.
   - **Post_REC**: Enter the number of seconds the system will record after video tamper occurs.
   - **Sequence**: Check to enable a custom sequence mode when motion is detected on the selected channel. Then click the channels you would like to display in the custom sequence mode.
   - **Snapshot**: Click the box to enable snapshot recording when video tamper occurs. You can then select which channels will save snapshots when video tamper occurs on the currently selected channel.
   - **Log Enable**: Check to activate log.
   - **Buzzer**: Check to enable the system buzzer when video tamper occurs on the currently selected channel.

5. Click **OK** to save changes.

14.3.11 Configuring Alarm Input Devices

You can connect alarm input devices such as motion sensors (not included) or glass break detectors (not included) to the system. The system can be set to trigger recording or take other actions when these devices are activated.

**To configure alarm input devices (not included):**

1. From the Main Menu, click and then click **Event>Local Alarm**.
2. Configure the following to activate an alarm input device:
   - **Alarm In**: Select the alarm input port the device is connected to.
   - **Enable**: Check to enable the alarm input device connected to the selected port.
   - **Type**: Select **NO (Normal Open)** or **NC (Normal Close)** depending on the type of alarm input device you have.

3. Configure the following system responses and parameters for the alarm input device:
   - **Period**: Click **Setup** to configure the times of the week when the selected device will be activated. By default, the device will be activated 24/7.
   - **Anti-dither**: Enter the anti-dither time. After the device triggers, if it triggers again within the anti-dither time, the system continues the event and includes the second activation within the first event, rather than creating a new event.
   - **Alarm Out**: Check the box to activate alarm output devices (not included) and select the alarm output devices (not included) will be activated when the selected device is triggered.
   - **Latch**: Enter the number of seconds an alarm output device will activate after the selected device is triggered.
   - **Show Message**: Check to enable an on-screen pop-up when the selected device is triggered.
   - **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
   - **Channels**: Select the channels that will record when the selected device is triggered.
   - **PTZ Activation**: Check to enable PTZ actions when the selected device is triggered (PTZ camera required; not included). Click **Setup** to select which PTZ actions will be taken by each camera.
   - **Snapshot**: Check to save a snapshot.
   - **Log Enable**: Check to activate log.
   - **Buzzer**: Check to enable the system buzzer.

4. Click **OK** to save changes.

14.3.12 Controlling Alarm Output Devices

You can connect alarm output devices (not included), such as sirens or strobe lights, to the system. The Alarm Output menu allows you to enable or disable alarm output devices and manually an activated device.

To access the Alarm Output menu:

1. From the Main Menu, click and then click **Event>Alarm Output**.
To control alarm output devices:

- To enable alarm output devices, select **Auto** or **Manual** for each device you would like to enable. Select **Stop** to disable the alarm output device. Click **OK** to save changes.
- To manually disable activated alarm devices, click **OK** under Alarm Release.

### 14.3.13 Configuring Hard Drive Warnings

Hard drive warnings will notify you if an issue is detected with the hard drive.

**To configure hard drive warnings:**

1. From the Main Menu, click and then click **Event>Warning>HDD**.

2. Under **Event Type**, select the hard drive event you would like to configure.
   - **No HDD**: No hard drive detected.
   - **Disk Error**: A hard drive error has been detected.
   - **Disk Full**: The hard drive is full or almost full. You can enter the percentage of disk space remaining that will trigger a warning under **Less Than** (e.g., when less than 10% of the hard drive is empty, trigger a warning). Disk Full warnings will not occur if overwrite is enabled.
   - **All**: Configure warnings for all hard drive events.

3. Configure the responses the system will take when the selected event occurs:
   - **Alarm Out**: Check the box to activate alarm output devices (not included) and select the alarm output devices (not included) will be activated when the selected event occurs.
   - **Latch**: Enter the number of seconds an alarm will activate after the selected event occurs.
   - **Show Message**: Show a popup message on the monitor.
   - **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
   - **Buzzer**: Check to activate the system buzzer.
   - **Log Enable**: Check to activate log.

4. Click **OK** to save changes.

### 14.3.14 Configuring Network Warnings

Network warnings will notify you if there your system loses connection to the Internet or local network or if there is an issue on your network.
To configure network warnings:

1. From the Main Menu, click \( \text{Main Menu} \) and then click Event>Warning>Network.

2. Under Event Type, select the event type you would like to configure.
   - Net Disconnection: The system has lost connection to the network.
   - IP Conflict: More than one device on your network has the same IP address.
   - MAC Conflict: More than one device on your network has the same MAC address.
   - All: Configure responses for all network events.

3. Configure the following for the selected event type:
   - Enable: Check to enable the selected event type.
   - Alarm Out: Check the box to activate alarm output devices (not included) and select the alarm output devices (not included) will be activated when the selected event occurs.
   - Latch: Enter the number of seconds an alarm will activate after the selected event occurs.
   - Show Message: Check to show a popup message when the selected event occurs.
   - Send Email: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 14.3.5 Configuring Email Alerts, page 55).
   - Buzzer: Check to activate the system buzzer.
   - Log Enable: Check to activate log.

4. Click OK to save changes.

### 14.3.15 Storage

The Storage menu allows you to configure the recording schedule and hard drives connected to the system.

### 14.3.16 Configuring the Video Recording Schedule

You can set a custom recording schedule according to your needs. For example, you can set the system to record continuously during business hours and record on motion detection only outside of business hours.

A custom recording schedule helps reduce the amount of hard drive space required, increasing the time your system can retain recordings.

To configure the video recording schedule:

1. From the Main Menu, click \( \text{Main Menu} \) and then click Storage>Schedule>Record.

2. Under Channel, select the channel you would like to configure or select All.
3. Configure the schedule as needed:

- **Continuous** or **Motion** to select the recording type you would like to configure.
- Click and drag on each day to customize the recording schedule. The schedule is set up as a grid, with each block representing one hour.
- Click next to **All** to link the recording schedules for all days. The icon for a day changes to when days are linked. You can also click the boxes next to individual days to link them to each other. If the recording schedule is linked, changes made to one of the days will apply to every day that is linked.
- Click to disable all recording of the selected type on the selected day.
- Click if you need to set a more precise schedule down to the minute.

4. Click **OK** to save changes.

14.3.17 **Configuring Pre-Recording**

The system can pre-record video when motion detection events occur.

**To configure pre-recording:**

1. From the Main Menu, click and then click **Storage>Schedule>Record**.

2. Under **Channel**, select the camera you would like to configure or select **All**.
3. Under **PreRecord**, select the duration for pre-recording.
4. Click **OK** to save settings.
14.3.18 Configuring the Snapshot Schedule

You can set a schedule for recording snapshots from the cameras.

To set up the snapshot schedule:

1. From the Main Menu, click and then click Storage>Schedule>Snapshot.

2. Under Channel, select the channel you would like to configure or select All.

3. Configure the schedule as needed:
   - Check Continuous or Motion to select the recording type you would like to configure.
   - Click and drag on each day to customize the recording schedule. The schedule is set up as a grid, which each block representing one hour.
   - Click next to All to link the recording schedules for all days. The icon for a day changes to when it is linked. You can also click the boxes next to individual days to link them to each other. If the recording schedule is linked, changes made to one of the days will apply to every day that is linked.
   - Click to disable all recording of the selected type on the selected day.
   - Click if you need to set a more precise schedule down to the minute.

4. Click OK to save changes.

14.3.19 Configuring Hard Drive Groups (Advanced)

Hard drive groups allow you to balance recordings across multiple hard drives. For example, you can record channels 1–4 to one hard drive and 4–8 to a second hard drive. This can reduce the amount of wear on the hard drives and may extend the life of the hard drives.

NOTE

- Two hard drives must be installed in the system to use hard drive groups, and both hard drives must be formatted as Read-write hard drives. For details on installing hard drives, see 20 LNR600 Series Hard Drive Installation, page 145.
To configure hard drive groups:

1. From the Main Menu, click and then click Storage>HDD Advance>HDD Setting.

2. Under HDD Group, assign a group to each hard drive. To set up two hard drive groups, assign one hard drive to group 1 and the other to group 2.

3. Click OK. The system will restart to apply changes.

4. When the system restarts, you must decide which channels will record to each hard drive group.

5. From the Main Menu, click and then click Storage>HDD Advance>Main Stream. For each channel, select the hard drive group you would like to record the main stream (high quality) video and then click Apply.
6. Click the **Sub Stream** tab. For each channel, select the hard drive group you would like to record the sub stream (reduced quality) video and then click **Apply**.

7. Click the **Pic** tab. For each channel, select the hard drive group you would like to record snap shots and then click **Apply**.

---

### 14.3.20 Configuring Holidays

You can set certain days as holidays. Holidays have a special recording schedule.

**To configure holidays:**

1. From the Main Menu, click and then click **Setting>General>Holiday**.

2. Click **Add New Holidays**.
3. Configure the following:

- **Holiday Name**: Enter a name for this holiday.
- **Repeat Mode**: Select *Once* for the holiday to occur only this year or *Always* for the holiday to be repeated each year.
- **Holiday Range**: Select *Date* to select a specific date, or select *Week* to select holidays based on which week they fall on.

4. Click **Add**. Now that you have added a holiday, an extra holiday setting is added to the recording schedule.

**NOTE**

You cannot delete holidays, but you can disable them by selecting **Close** under the **Status** dropdown and then click **Apply**.

---

### 14.3.21 Formatting the Hard Drive

The HDD Manager menu allows you to format the hard drive. If you install a new hard drive, you must format the hard drive using the system before you will be able to record.

**To format the hard drive:**

**CAUTION**

Formatting the hard drive erases all data on the hard drive. This step cannot be undone.

1. From the Main Menu, click **Storage** and then click **HDD Manager**.

2. Select the hard drive you would like to format and then click **Format**. Click **OK** to confirm.
3. Click OK to save changes. The system will restart to complete the formatting process.

14.3.22 Configuring Hard Drive Type

The system supports the following hard drive types:

- **Read/Write**: Normal recording hard drive.
- **Read only**: The system can playback data from this hard drive, but it will not record to it.
- **Mirror**: The hard drive will be used for mirror recording only. You must set up mirroring recording before this feature will work.

To set the hard drive type:

1. From the Main Menu, click **...** and then click **Storage>HDD Manager**.

![HDD Manager](image)

2. Click the hard drive you would like to configure.
3. Under **Type**, select **Read/Write**, **Read only**, or **Mirror**.
4. Click OK to save changes. The system will restart to complete this operation.

14.3.23 Setting up Hard Drive Mirroring (Advanced)

A mirror hard drive can be used to automatically backup video footage recorded to the recording (read/write) hard drive. When a mirroring hard drive is installed, the system can be set to record cameras in parallel to both the recording hard drive and the mirror hard drive. This way, the footage is automatically backed up if the recording hard drive fails.

How hard drive mirroring works:

![Hard Drive Mirroring Diagram](image)

1. Security system.
2. Primary hard drive.
To set up hard drive mirroring:

1. From the Main Menu, click and then click Storage>HDD Manager.
2. Click the Type drop-down under the second hard drive and select Mirror.

CAUTION
Setting a hard drive for mirroring erases all data on the hard drive. This step cannot be undone.

3. Click OK to apply changes. Click Yes to confirm. The system will format the hard drive and restart.

4. When the system restarts, click and then click Storage>Schedule>Record.
5. Under Channel, select the channel you would like to enable for mirror recording, then check Mirror. Repeat the process for any additional channels.

6. Click OK to save changes.

14.3.24 Configuring General System Settings
You can use the General menu to configure miscellaneous system settings.
To configure general settings:

1. From the Main Menu, click [Main Menu] and then click Setting>General>General.

2. Configure the following:
   - **Device No.**: Select the remote control address of the system. See 7.1 Setting the Remote Control Address, page 15.
   - **Language**: Set the system languages. Available options are English, French, and Spanish.
   - **Video Standard**: Select NTSC (North America) or PAL (Europe).
   - **HDD Full**: Select Overwrite for the system to overwrite the oldest recordings when the hard drive is full or select Stop Record for the system to stop recording when the hard drive is full.
   - **Pack Duration**: Select how the duration (in minutes) the system will store video files. For example, if this is set to 30 minutes, the system will create a new video file for each 30 minutes of continuous recording.
   - **Instant Playback**: Select the amount of time (in minutes) the system will go back when instant playback is activated in live view.
   - **Auto Logout**: Select the idle time (in minutes) before the system will logout the current user.
   - **IP Camera Sync**: Select how often (in hours) the NVR will update the time on the IP cameras.
   - **Navigation Bar**: Check to enable the Navigation Bar that comes up when you left click in live view.
   - **Startup Wizard**: Check to enable a setup wizard when you start up the system.
   - **Mouse Sensitivity**: Use the slider to adjust the mouse speed.

3. Click **OK** to save changes.

14.3.25 Setting the Monitor Resolution (Display)

The Display menu allows you to configure the systems monitor resolution and other display settings.
To set the monitor resolution:

1. From the Main Menu, click ➫ and then click Setting>Display>Display.

2. Under Resolution, select the correct resolution for your monitor.
3. Click OK to save changes. Click OK again to restart the system using the new resolution.

To configure other display settings:

1. From the Main Menu, click ➫ and then click Setting>Display>Display.

2. Configure the following:
   - Transparency: Select the menu transparency.
   - Time Display: Check to show the time on the monitor.
   - Channel Display: Check to show the channel names on the monitor.
   - Image Enhance: Check for the system to digitally improve the video quality on the
     live display. This setting does not affect recordings.
   - Original Scale: Set the system to show the true aspect ratio of the cameras on the
     live display. This may add black bars on the top and bottom of the image.
3. Click OK to save changes.

14.3.26 Saving Your System Configuration to a USB Thumb Drive

The system allows you to save your current system configuration to a USB thumb drive
(not included). This is useful if you want to backup your current settings.

NOTE
This function only saves settings created in system menus. It does not save or backup any video.
To save your system configuration to a USB thumb drive:

1. Insert a USB thumb drive (not included) into one of the USB ports.

2. From the Main Menu, click Setting>Config Backup.

3. Under Device Model, select the USB device where you would like to save the configuration.

4. Click EXPORT to save your current system configuration.

To restore a saved system configuration:

1. Insert a USB thumb drive (not included) with a saved system configuration into one of the USB ports.

2. From the Main Menu, click Setting>Config Backup.

3. Under Device Model, select the USB device.

4. Click the folder with the configuration files you would like to restore. Configuration file folders are labeled “Config” and then the time and date the configuration was saved (e.g. Config_20140425103727).

5. Click Import to restore the system configuration.

6. Click OK to confirm. The system will restart to complete the operation.

14.3.27 Setting the System to Factory Defaults

The Default menu allows you to reset the system to factory default settings.
To reset the system to factory default settings:

1. From the Main Menu, click and then click Setting>Default.

2. Check the menus you would like to reset to default settings.
3. Click OK.
14.3.28 Upgrading Firmware from USB

Firmware upgrades provide enhanced functionality. The system will automatically check for firmware upgrades if it is connected to the Internet. The system also supports firmware upgrades from a USB thumb drive (not included).

To upgrade firmware from a USB drive:

1. Download the firmware upgrade from www.lorextechnology.com/support.
2. Extract the firmware file and copy the firmware to a blank USB thumb drive.

   **NOTE**
   Do not have any folders on the USB thumb drive—just the firmware file.

3. Insert the USB thumb drive to a USB port on the system.
4. Right-click and then click **Main Menu**. Click **Setting>Upgrade**.
5. Click **Upgrade**.
6. Select the firmware file on the USB drive and click **Start**.

   **WARNING**
   **DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING firmware INSTALLATION**
14.4  **Shutdown**

Use the Shutdown menu to shutdown, restart, or log out of the system.

**To access the Shutdown menu:**

1. From live view, right-click and select **Main Menu**.
2. Enter the system User Name (default: **admin**) and Password (default: **000000**) and click **OK**.
3. Click **Shutdown**.
4. Select one of the following:

   - **Logout**: Log out the account that is currently active.
   - **Shutdown**.
   - **Restart**.
Connecting to Your System Over the Internet on PC or Mac

This system features connectivity using the exclusive FLIR Cloud™. This cloud-enabled service allows for Internet connectivity without requiring any network configuration. Up to 3 devices may connect to the system at the same time.

NOTE

- Except where noted, the PC and Mac instructions in this section are the same.
- For smartphone/tablet setup, see page .
- For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

15.1 System Requirements

Your system must meet the system requirements below:

<table>
<thead>
<tr>
<th>Description</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Core 2 Duo 3.0GHz</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows™ 8/7/Vista</td>
</tr>
<tr>
<td></td>
<td>Mac OSX 10.7 and above</td>
</tr>
<tr>
<td>Memory</td>
<td>2GB</td>
</tr>
<tr>
<td>Video</td>
<td>512 MB of video memory and above</td>
</tr>
<tr>
<td>Network (LAN)</td>
<td>10/100 BaseT Network</td>
</tr>
<tr>
<td>Network (WAN)</td>
<td>1 Mbps upstream</td>
</tr>
<tr>
<td></td>
<td>High-speed Internet service is required to remotely connect to your system.</td>
</tr>
</tbody>
</table>

15.2 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system. Connect the other end of the Ethernet cable to an empty LAN port (usually numbered 1~4) on your router.
3. Reconnect the power adapter to power the system back on.

15.3 Step 2 of 3: Obtain the System’s Device ID

The Device ID is a unique code that allows your system to handshake with FLIR Cloud™ servers for a secure connection over the Internet.

To find the Device ID:

1. The Device ID is located on a sticker on the system.

2. Write down the Device ID of the system.

15.4 Step 3 of 3: Connect to the System Over the Internet

Follow the steps below to connect to the system over the Internet.

**NOTE**

Make sure to upgrade your system to the latest firmware version. You must have the latest firmware and client software to connect to the system over the Internet.

To connect to the system over the Internet:

1. Download and install the client software. To find the client software visit www.lorextechnology.com, search for the model number of your product, click on your product in the search results, and click on the Downloads tab. Next:
   - PC Users: Download and install the Client Software for PC.
   - Mac Users: Download and install the Client Software for Mac. Double-click to extract the software. Then, drag the software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (🖥️) from the desktop or Applications list.
3. Log into the Client Software using the Client Software user name (default: admin) and password (default: admin) and then click Login.

4. Click Add Device.

5. Enter the following:
Connecting to Your System Over the Internet on PC or Mac

5. **Device Name**: Choose a name for your system of your choice.
5. **Device ID**: Manually enter the Device ID printed on the label.
5. **Client Port**: Enter the Client Port (default: 35000).
5. **User Name**: Enter the system User Name (default: admin).
5. **Password**: Enter the system Password (default: 000000).

6. Click **Add**. If this is the first time you are connecting, you will be prompted to change the system password.

7. Enter a new 6 character password and click **OK**. This password will be used to connect to your system from now on.

8. Click **Add** then **OK**.
9. Click and drag **Default Group** to the display window to open your cameras in live view.

**Congratulations!** You can now connect over the Internet to view and playback video on your computer.
FLIR Cloud™ Client allows you to connect to multiple systems from a PC or Mac.

16.1 Home Page

The Home Page allows you to access all the tabs within the software. Each tab allows you to access different features.

To open tabs:

Click a tab from the Home Page to open it or click the button at the top of the screen from within any tab to open a new tab.

16.2 Live View

The Live View tab is where you can view live video from connected systems.

To view live video from a system:

1. Click and then click to create a Live View tab.

2. Click and drag a DVR, NVR, group, or individual camera to open live video. To access individual cameras, you can click + to expand groups or systems.
16.2.1 Live View Controls

1. **Live display**: Double-click to expand the area. Right-click to access additional options. Hold the mouse over the display area to access the camera toolbar.

   **Camera toolbar:**

   1. **Streaming quality**: Shows the bitrate and resolution for the stream, and shows if display is showing the Sub Stream or Main Stream.
   2. **Manual recording**: Click to start/stop manual recording.
   3. **Snapshot**: Click to save a snapshot.
   4. **Mute/unmute**: Click to mute/unmute audio (audio camera required).
   5. Not supported.
   6. **Instant playback**: Plays back the most recently recorded video from the camera. By default, it will play back the last 5 minutes of recorded video from the camera.
   7. **Digital zoom**: Click to enable digital zoom mode. Click and drag over the display area to zoom on the camera. Then click and drag to pan. Click the icon again to zoom out.
   8. **Disconnect**.

1. **Split-screen mode**: Click to select split-screen layout.

2. **Aspect ratio**: Use the drop down menu to select the aspect ratio for the selected camera. **Original** uses the actual aspect ratio of the image. **Full-win** stretches the image to fill up the entire display area.
3. **Full-screen**: Click to open full-screen mode. Press ESC to exit full-screen mode.

4. **Save view**: Click to save the current display layout and open cameras as a view. Then enter a name for the view.

5. **Start/stop tour**: Click to start the tour. During the tour the client will cycle through all saved views every few seconds. Click again to stop the tour.

6. **PTZ Controls**: Controls for PTZ cameras (not included). See 16.3 *Controlling PTZ Cameras*, page 86 for details.

7. **View**: Click View to access view menu. Then double-click on a view to open it in the display area.

8. **Devices**: Shows a list of groups, cameras, and systems connected to the client. Drag items to the display area to open live video. Right-click to view additional options.

### 16.2.2 Opening Live View in Multiple Monitors

If your computer has multiple monitors, you can open more than one Live View tab and move them to secondary monitors. This allows you to monitor cameras on multiple monitors at the same time.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using multiple monitors significantly increases the amount of computing resources necessary to run the application and may affect performance.</td>
</tr>
</tbody>
</table>

**To open Live View in multiple monitors:**

1. Click and then click to create a Live View tab.
2. Click and drag the tab outside of the client window to create a new window. You can drag the window to one of the secondary monitors.

**Result**

![Client window with PTZ control panels](image)

### 16.3 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the client.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must ensure the PTZ camera is properly connected to your system and your system is configured to detect it before you can control them using the client.</td>
</tr>
</tbody>
</table>

**To control PTZ cameras:**

- Click the display area with the PTZ cameras and use the on-screen PTZ controls.
PTZ controls:

1. **Open menu**: Click to open camera OSD menu controls. This feature may not be supported for all camera models.

2. **Move camera**: Click the arrows to move the camera.

3. **Zoom +/-**: Click to zoom the camera in and out.

4. **Focus +/-**: Click to increase/decrease the focus.

5. **Iris +/-**: Click to increase/decrease the iris.

6. **Advanced**: Click to access advanced PTZ controls.

### 16.3.1 PTZ Presets

Presets will save a camera position for quick retrieval.

**To add presets:**

1. Click to open the Advanced controls. Select **Preset**.

2. Click .
3. Select the number of the preset you would like to add.

![Image of preset selection]

4. Move the camera to the desired position.

5. Click ![Save preset icon] to save the current position as a preset.

**To go to a saved preset:**

1. Select the preset number from the list or click ![Go to preset icon] to go to the currently selected preset.

### 16.3.2 PTZ Tours

Tours will cycle through a set of presets.

**To configure a PTZ tour:**

1. Click ![Advanced controls icon] to open the Advanced controls. Select **Tour**.

2. ![Tour selection image]

3. Under **Cruise ID**, select the number of the tour you would like to configure.

4. (Optional) Under **Cruise Name**, enter a name for the tour.
5. Use the chart to select which presets you would like to include in the tour and the order of presets.

- **Preset**: Select the preset number.
- **Time(s)**: Enter the time in seconds the camera will remain on the selected preset.
- **Operation**: Click to add a preset to the tour. Click to delete a preset from the tour.

6. Click **OK** to save changes.

**To run a PTZ tour:**

1. Select the tour number and click  .

16.3.3 **PTZ Pattern**

Patterns automatically cycle the camera between two positions.

**To create a pattern:**

1. Click  to open the Advanced controls. Select **Pattern**.
2. Select the number of the pattern you would like to set up.

3. Move the camera into the desired start position.

4. Click  to start recording the pattern.

5. Move the camera to the desired end position. Then, click  to stop recording the pattern.

**To run a pattern:**

1. Select the pattern number and click  .
16.3.4  PTZ Scan
Scan automatically cycles between a left and right point.

To set up scan mode:

1. Click \(\text{✓}\) to open the Advanced controls. Select \text{Scan}.

2. Move the camera to the desired left position and click \(\text{✓}\).

3. Move the camera to the desired right position and click \(\text{✓}\).

To run scan mode:

1. Click \(\text{✓}\).

16.3.5  PTZ Pan
Pan makes the camera continuously pan 360°.

To run Pan mode:

1. Click \(\text{✓}\) to open the Advanced controls. Select \text{Pan}.

2. Click \(\text{✓}\).

16.4  Playback
You can use Playback mode to playback video saved on systems connected to the client.

To access Playback mode:

- Click \(\text{✓}\) and then click \(\text{✓}\) to create a Playback tab.
To playback video:

1. Check the channels you would like to play back from in the Device List.
2. Under **Type**, check the file types you would like to search for.
   - **All**: All recordings.
   - **General**: Continuous recordings.
   - **MD**: Motion recordings.
   - **Alarm**: Alarm recordings. Your system must support alarm devices (not included) to use this feature.
3. Under **Stream**, select **Main Stream** to search for Main Stream recordings (high quality) or **Sub Stream** to search for Sub Stream recordings (smaller file size).
4. Select the start time and end time for your search under **From** and **To**. You may not search more than 24 hours of video.
5. Click **Search**. Wait for the client to find video saved to the system.
6. Click inside the playback bar to start playback.
16.5 Playback Controls

1. **Display area**: Double-click to expand/return to split-screen mode. Hold the mouse over the display area to open the camera toolbar.

   ![Main Stream](image)

   - **Snapshot**: Click to save a snapshot.
   - **Digital zoom**: Click to enable digital zoom mode. Then, click and drag to zoom in. Click and drag to pan the camera. Click again to zoom out.

2. **Event**: Click to view recordings based on a list of events and files.
3. **Record**: Click to view recordings on a timeline.
4. **Sync**: Click to sync playback between channels. This forces all channels to playback from the same time.
5. **Pause/play**.
6. **Stop**.
7. **Frame-by-frame**: Click to advance the video by a single frame.
8. **Playback speed**: Use the slider to adjust the playback speed.
9. **Mute**.
10. **Volume**.
11. **Split-screen**: Select split screen configuration.
12. **Full-screen**: Click to open playback in full-screen. Press ESC to exit full-screen.
13. **Timeline zoom**: Use the slider to zoom in/out on the timeline.
14. **Playback timeline**: Shows recordings from the selected channels on a timeline. Click inside the timeline to start playback or select a playback time. Each type of recordings is shown in a different color. Continuous recordings are green, motion recordings are yellow, and alarm recordings are red.
15. **Video clip**: Click to start a video clip. You can download video clips to your hard drive.
16. **Download list**: Click to see a list of files you have downloaded and the progress of files that are currently downloading.

17. **Search**: Search for video on the selected channels based on the search parameters you set.

18. **Device list**: Select the channels you would like to search or playback video from.

### 16.6 Downloading Video to your Computer Hard Drive

You can download video to your computer hard drive to save important events or share them. It is recommended to download video of important events as soon as possible to ensure they are not overwritten by new recordings.

**NOTE**

**PC Users**: You may need to run FLIR Cloud™ Client as an administrator to download files to your hard drive.

To download video files:

1. Start playing back video using the steps in 16.4 *Playback*, page 90.

2. Click to start a video clip at the current playback time. Click to stop the video clip.

3. Configure the following save options:

   ![Save Options](image)

   - **Path**: Use the default save folder or click **Browse** to select a different folder.
   - **File Format**: Select **Original Format** to save to .dav format (requires the video player). Select **AVI** to save files to .avi format (can be played in VLC Media Player).

   **NOTE**

   The Mac version only supports downloading video to .dav format.

   - **Download Video Player**: Check to save a copy of the video player with the downloaded file.

4. Click **OK** to start the download. A status screen will pop up to show progress on downloaded files.
NOTE

To retrieve downloaded video files:
- **PC Users**: Browse to the folders listed in General>File.
- **Mac Users**: Browse to the folders listed in General>File. To get to the default location, open Applications in Finder, right click on FLIR Cloud Client and select Show Package Contents. Then, navigate to the desired folder.

16.7 Alarm

The Alarm menu allows you to view a list of alarms received by the client software.

NOTE

You must set up alarms in the Alarm CFG menu before they will appear in this list. See 16.12 Alarm CFG, page 99 for more details.

To access Alarms:
- Click ![Alarm icon] and then click ![OK].

Alarm menu overview:

1. **Number of alarms**: Shows the number of open alarms.
2. **Alarm list**: Shows the list of alarms and information on when they occurred and which systems and channels triggered them.
3. **Alarm Process**: You can close alarms by selecting one of the options and clicking **OK**.
4. **Options**: Check to enable the following:
   - **Display Link Video**: Open live video to monitor alarms on a continuous basis.
   - **Display Overlay Window**: Show the overlay controls. They allow you to enable/disable sound alerts and quickly jump back to the Alarm menu from another tab.
   - **Pause Refresh**: Stop refreshing the live video in the video popup.

16.8 **Log**

The Log menu allows you to view logs for the client software or to view logs for connected systems.

**To access logs:**

- Click and then click .

**To view client logs:**

1. Click **Client Log** to view logs for the client software.

2. Configure the following:
   - **Start Time/End Time**: Select the start and end times to search for logs.
   - **Log Type**: Select the type of logs to search for.

3. Click **Search**.

**To view logs from connected systems:**


1. Click **Device Log** to view logs from connected systems.

2. Configure the following:
   - **Start Time/End Time**: Select the start and end times to search for logs.
   - **Log Type**: Select the type of logs to search for.
   - **Device Name**: Select the system you would like to view logs from.

3. Click **Search**.

### 16.9 E-map

E-Map allows you to place cameras over a still image. For example, you can use the E-Map to create a virtual map of your cameras over a floor plan of your home or business.

**To create an E-map:**

1. Click ☐ and then click ☐.

2. Click **Add Map**.
3. Configure the following:

![Add Map](image)

- **Name**: Enter a name for your e-map of your choice.
- **Picture**: Click File and then select a .png, .bmp, or .jpg image on your computer to use as the e-map.
- **Describe (optional)**: Enter a text description of the e-map.

4. Click **Save**.
5. Click **Edit** to edit the e-map.

6. Click and drag cameras from the device list to place them on the map.

![FLIR Cloud](image)

To open cameras from the e-map:
1. Click **View**.
2. Double-click cameras on the map to open live video.

16.10 Devices

The Devices menu is where you can manage systems connected to the client software.

To access the Devices menu:
- Click and then click

Devices overview:

1. Devices Found: Shows systems that are connected to the same network as the computer where the client is installed. Once you connect to the system, it moves to the bottom of the screen.
2. Search: Refresh the list of systems connected to the network.
3. Add: Add checked systems to the client software.
4. Device list: Shows a list of systems connected to the client software, and shows which systems are online.
5. Add Device: Add a remote system using a Device ID or IP/DDNS address.
6. Delete: Delete the selected system.
7. Import: Import a list of systems from a saved .xml file.
8. Export: Export a list of currently connected systems to an .xml file. This is useful if you need to re-install the software or if you want to open the same list of systems on a different computer.
9. Delete: Delete system.
11. **Edit**: Edit the connection details for the system.

### 16.11 Device Config

The Device Config menu allows you to remotely configure settings for connected systems.

**To access the Device Config menu:**

- Click and then click.
- Click on a system in the device list to see the settings available for that system and then configure settings as needed.

![Device Config Menu](image)

**NOTE**

The settings available depend on the model of system you have.

### 16.12 Alarm CFG

The Alarm CFG menu allows you to configure alarms for the client software. The client software will alert you by popping up live video and playing sound alerts.

**NOTE**

Alarm upload must be enabled on the system in order for it to send the alarm to the client software.

**To create alarms:**

1. Click and then click.
2. Click **Add** to create a new alarm.
3. In the **Alarm sources** menu, you set up the parameters that trigger the alarm.

- Under **Alarm Type**, select the alarm type that will trigger an alarm. For example, you can select Motion Detect for the alarm to be triggered by motion.
- Select the systems or channels you would like to trigger an alarm. Continuing the example, if CAM 1 is selected, the alarm will be triggered if there is motion on CAM 1.
- Click **Next**.
4. In the **Alarm link** menu, you set up the responses to alarms. Select the channels that will pop up or alarm out devices (not included; not all systems support alarm out devices) that will be triggered by an alarm.
   For each channel selected, configure the following:

   - **Video**: Pop up a window with live video from the selected channel, like the one below.
   - **Record**: Record video from the selected channel.

   **NOTE**
   
   **PC Users**: You may need to run the client software as admin to record.

   - **Preset**: If you select a PTZ camera, you can select the preset that will be activated when an alarm occurs.
   - **Stay Time**: Enter how many seconds the video window will stay open or record when an alarm occurs.

5. Click **Next**.
6. In the **Period** window, configure times the alarm will be activated.

7. Click **Confirm** to save the alarm.
To manage alarms:

1. **Export**: Export current list of alarms as an xml file.
2. **Import**: Import list of alarms.
3. **Delete**: Delete selected alarm.
4. **Add**: Add new alarm.
5. **On/off**: Click to enable/disable alarm.
6. **Delete**: Click to delete alarm.
7. **Edit**: Click to edit alarm settings.

### 16.13 Tour & Task

The Tour & Task menu is where you can set up custom views for the system. You can also set up tours, which sets the client to automatically cycle through views.

**To start a tour:**

- Click 🔄 in Live View to start a tour. The live view will automatically cycle through all views you have set up in the Tour & Task menu. Click again to stop the tour.

**To add views:**

1. Click 🔄 and then click 📊.
2. Click + to create a new view.
3. Under **Name**, enter a name for your view.
4. Under **Stay Time**, enter the number of seconds the view will be shown before the client switches to the next view.
5. Select the split-screen mode you would like to use for the view and then click and drag channels to the empty grid areas to select channels to be shown in the view.
6. Click **Save** to save the view. Or click **Add More** to save the view and create another view.

**16.14 Account**

The Account menu is where you can set up user accounts and passwords for the client software. To simplify management, you can group user accounts according to role. A role determines the permissions an individual user account can have.

To access the account menu:

- Click ![Account Icon] and then click ![Account Menu].

**16.14.1 Managing User Accounts**

By default, the client software includes an admin account that has full access to all features of the software and all connected systems. You can add user accounts with customized levels of access.

NOTE

The admin account cannot be deleted. The default user name for the admin account is **admin** and the default password is **admin**.
To create a user account:

1. Click Add.

2. Configure the following settings for the user account:
   - **User Name**: Enter a user name for the account.
   - **Role**: Select the role for the user account. By default, the user account gains all the permissions of the role selected, but you can deactivate permissions as needed.
   - **Password/Confirm Password**: Enter the password for the user account.
   - **Remarks (Optional)**: Enter a text description of the user account.
   - **User Rights**: Check the permissions that will apply to the user account. If you click on LiveView, Playback, and PTZ, you can select which channels the user account can access in the Channel List section.

3. Click Save to create the account.

To switch between user accounts:

- Click  

To modify a user account:

```
NOTE
Admin accounts with Account Setup permissions can change account passwords. A user cannot change his own password.
```

- Click  next to the user account you would like to modify. Edit the user account details and click Save.
To delete a user account:

1. Click next to the user account you would like to delete. Click OK to confirm.

16.14.2 Managing Roles

Roles make it easier to manage user accounts by determining the permissions an individual user account can have. By default, a new user account is given all the permissions of the role they are assigned to.

To create a role:

1. Click the Role tab.
2. Click Add.

3. Configure the following settings for the role:

   • **Role Name**: Enter a name for the role.
   • **Remarks (Optional)**: Enter a text description of the role.
   • **Role Rights**: Check the permissions that will apply to user accounts assigned this role. If you click on LiveView, Playback, and PTZ, you can select which channels may be accessed in the Channel List section.

4. Click Save.

To modify a role:

• Click next to the role you would like to modify. Edit the role details and click Save.
To delete a user account:

1. Click next to the role you would like to delete. Click OK to confirm.

16.15 General

The General menu is where you can configure application settings for the client software.

To access the General menu:

• Click and then click.

16.15.1 Basic

The Basic menu contains general settings for the client software.

The Basic menu contains the following settings:

• **Log Saved Time**: Select the number of days you would like the client to save log entries.
• **Instant Playback Time**: Select the number of minutes the system will go back when you start an instant playback.
• **Network Capability**: Select the speed of your computer's network connection.
• **Resume Live View State**: Check for the client to resume live view when it starts up. The live view will open to the last view that you had open.
• **Auto login application**: Check for the client to automatically login when it starts up without entering a user name or password.
• **Auto Login Windows**: Not supported.
• **Language**: Select the language for the client software.
• **Sync Time**: Check to have the client software sync time with your computer's system time. Select the time the software will sync the time. Click **Sync Now** to manually sync the time.
• **Time Format**: Select 12-Hour or 24-Hour time format. You must close the client and restart it to apply this setting.

**NOTE**

Click **Save** to save setting changes.

16.15.2 File

The File menu allows you to select the folders where the client software will save downloaded video files and snapshots.
The File menu contains the following options:

- **Snapshot Path**: Click **Browse** to select the default folder to save snapshots.
- **Record Path**: Click **Browse** to select the default folder to save video recordings.
- **Config Path**: Click **Browse** to select the folder where the client will save software config files.

**NOTE**

Click **Save** to save setting changes.

**PC Users**: You may need to run the client software as admin to save files to enable snapshot or video recording.

### 16.15.3 Alarm Prompt

The Alarm Prompt menu allows you to configure audio alerts. The client will play audio alerts when events occur. You can replace the default sounds with any .wav file.

**NOTE**

You must configure alarms in the Alarm CFG menu before the client will play alarm sounds.

The Alarm Prompt menu has the following options:

- **Open Audio**: Check to enable audio alerts.
- **Loop**: Check to repeat audio alerts until acknowledged.
- **Camera Masking**: Select or preview the sound that will play for camera masking alarms.
• **Motion Detect**: Select or preview the sound that will play for motion detection.
• **Video Loss**: Select or preview the sound that will play for video loss alarms.
• **Disk Full**: Select or preview the sound that will play for disk full alarms.
• **Disk Error**: Select or preview the sound that will play for disk errors.
• **External**: Select or preview the sound that will play for external alarms (triggered by sensor devices, which may not be supported on all systems).

• **E-map flashes when alarm occurs**: If the camera has alarms enabled and is added to an e-map, a 📚 appears on the e-map when an event occurs.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Save</strong> to save changes.</td>
</tr>
</tbody>
</table>

### 16.15.4 Version

The Version menu shows you which version of the client software you are using. It is recommended to always run the latest version of the software. To find the latest version of the client software, visit [www.lorextechnology.com](http://www.lorextechnology.com), search for the model number of your product, click on your product in the search results, and click on the **Downloads** tab.
Connecting to your System Using Smartphone or Tablet Apps

17.1 FLIR Secure™

You can remotely view camera streams from your recorder on compatible mobile phones and tablets. This system features connectivity using the new and exclusive FLIR Secure™ app, which allows for easy access using a mobile device without requiring network configuration or a computer to complete the setup.

**NOTE**

Up to 3 devices can connect to the system at the same time.

17.1.1 Connect to Your Mobile Device Using FLIR Secure™

Use the FLIR Secure™ application to connect to your recorder on your mobile device.

Requirements

- Connect your recorder to your router using an Ethernet cable (included).
- **Make sure to upgrade your recorder to the latest firmware version.** You must have the latest recorder firmware and mobile app to connect to the recorder over the Internet.

**NOTE**

For the latest list of supported apps and devices, visit [www.lorextechnology.com/support](http://www.lorextechnology.com/support).

To add a device:

1. Install the free FLIR Secure™ app from the App Store or Google Play Store.
2. Tap the FLIR Secure™ icon (📱) to open the app.
3. Tap **SIGN UP**, then enter your email address and password to create a new account.

**NOTE**

If you already have an account, enter your email address and password and tap **LOG IN**. If you re-install FLIR Secure™ and log in, the app prompts you to re-enter login credentials for all the devices in your account.

4. Tap 📲, then tap **Security System**.
5. Use the camera of your mobile device to scan the QR code on top of your recorder.

**NOTE**

If you cannot scan the QR code, tap 📲 and enter the **Device ID** located under the QR code.

**NOTE**

Make sure your device is on and connected to the network.

6. Enter the recorder's user name (default: **admin**), and the recorder's password (default: **000000**). Tap **Done**.
7. On the **Update Device Name** screen, enter a new name for your device and tap **NEXT**. You will be prompted to change the device password.
8. Enter a new **6 character password** and tap **DONE**. This password will be used to log on to your system from now on.
9. The app displays all the cameras that are connected to your recorder on the home screen. Tap any camera to stream live video from it.

**NOTE**

If you already have cameras and recorders associated with your FLIR Secure™ account, you can find them under the **Cameras** and **Security Systems** tabs in the FLIR Secure™ home screen.

### 17.1.2 iPhone

#### 17.1.2.1 FLIR Secure™ Interface

**Home Screen**

1. ![Add Device Icon]: Tap to add new devices or create new groups.
2. ![Information Icon]: Tap to view the FLIR Secure™ app information. You can also log out from the FLIR Secure™ app in this screen by tapping **Log Out**.
3. **Device Name / ID**
4. **View All**: Tap to stream live video from all connected cameras. Tap (hold for one second) and drag a camera channel to rearrange it.
5. **Camera channels**

**Single-Channel Live View**
1. **Channel number / channel name**
2. **Playback History**: Tap to view recorded videos saved on your recorder's hard drive.
3. **Live View**: Double-tap to zoom in. Turn your mobile device sideways to view in landscape mode, or hold upright to view in portrait mode.
4. **Disconnect camera channel**: Tap to disable live video, video recording, and push notifications. Tap again to enable the disconnected camera.
5. ****: Tap to open channel settings for the selected camera channel. You can change the channel name, enable PTZ controls, enable camera's microphone (for audio-enabled cameras only), and enable motion detection notification for the selected camera channel. Tap **Save** after you make your changes. On the channel settings screen, swipe to the bottom of the screen and tap **DEVICE SETTINGS** to view your device information. You can also change the device name, enable / disable mobile notifications for your device, enable / disable device error notifications, and check the Cloud subscription plan for your camera channels.
6. **Quick Playback**: Tap to play back video from the last 30 seconds for the camera channel. Tap anywhere on the video to pause / play the playback.

7. **Enhance Res**: Tap to enhance the resolution of the camera image.

8. **Snapshot**: During single-channel live view and quick playback mode, tap to take a screenshot of the currently-selected channel. Your mobile device must be in portrait mode.

### 17.1.2.2 Creating Groups

The **CREATE GROUP** function allows you to group multiple cameras from various devices in your FLIR Secure™ account. You can then quickly bring up the selected group of cameras in Live View without having to individually select each camera.

1. From the home screen, tap 

2. Tap **CREATE GROUP**. The FLIR Secure™ app displays all cameras that are connected to your FLIR Secure™ account.

3. Tap the **Name** text box and enter a group name of your choice.

4. Select the cameras you would like to include in the new group and tap **Create**.

#### NOTE

- You can add a maximum of 8 cameras to a group.
5. On the home screen, you will notice a new tab called **Groups**. Tap to view the new group you created.
6. Tap the group to stream live video from all the cameras in the group.

### 17.1.2.2.1 How to Edit a Group

**To edit a group:**

1. On the home screen, tap the **Groups** tab.
2. Tap **Edit** next to the group you want to edit. The **Edit Group** screen appears.
3. Tap **Save** after you make your changes.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap the <strong>Name</strong> text box to rename your group.</td>
</tr>
</tbody>
</table>

### 17.1.2.2.2 How to Delete a Group

**To delete a group:**

1. On the home screen, tap the **Groups** tab.
2. Tap **Edit** next to the group you want to edit. The **Edit Group** screen appears.
3.Swipe to the bottom of the screen and tap **Delete Group**.
4. A confirmation pop-up appears. Tap **Delete Group** again. Your group is deleted.
17.1.2.3 Using History Mode

History mode allows you to view recorded video saved on your recorder's hard drive.

**To use History mode:**

1. From the Home screen, tap **View All** next to the device name / device ID of the recorder you would like to play back from. The FLIR Secure™ app will stream live video from all cameras connected to your recorder.

2. Tap 🔄.
3. The **History** screen appears.

**History Screen**

- 1. Go back to Live View
- 2. Device Name / ID of your recorder
- 3. Shows the number of cameras connected to your recorder
- 4. Play multiple recordings within a desired time frame.
- 5. Tap to select a time scale. You can search recordings by week, day, hour, or minute.
- 6. Tap the left / right arrow to select the day you would like to play back from.

NOTE

If you select **WEEK** as the time scale, this becomes a range of dates, for example: May 08 — May 14.

- 7. Changes according to the time scale selected. For example, if you select **DAY** as your time scale, this area shows: 12 AM, 4 AM, 8 AM, etc.
- 8. Swipe up / down to select the camera channel you would like to play back from.
- 9. Swipe left / right to search for recordings. Tap inside the timeline to select the playback time. Playback starts immediately at the selected time.

NOTE

: Motion recording

: Continuous recording

NOTE

Recordings are also color-coded: orange for motion recording and blue for continuous recording. No color indicates that no recordings are available.
Connecting to your System Using Smartphone or Tablet Apps

Playback Controls:

1. Channel, day, and time indicator
2. Tap anywhere in the playback video to pause / play.
3. Indicates the type of recording, for example: motion or continuous event.
4. **Playback duration:** Shows the length of the recording and how much has been viewed. You can tap and drag inside the time bar to select the time you wish to view.

17.1.2.3.1 *How to Play Multiple Recordings*

To play multiple recordings within a desired time frame for a single channel:

1. From the Home screen, tap the camera channel under the recorder you would like to play back from. The FLIR Secure™ app will stream live video from the selected camera channel.
2. Tap . The **History** screen appears.
3. Tap . The **Play Recordings** screen appears.
4. Play Recordings Screen

1. Select the time scale. You can search recordings by week, day, hour, or minute.
2. Tap the left / right arrow to select the day you would like to play back from.
3 and 4: Playback start and end markers
5. Tap and drag the markers to set a time frame for playback. The marker on the left sets the start time for playback and the marker on right sets the end time.
6. Tap . Playback will start within the time frame that you selected.

**NOTE**
Tap / to play the previous / next playback video, respectively.

17.1.2.4 How to Manage Devices in the FLIR Secure™ app

You can add, delete, or modify your devices in the FLIR Secure™ app:

To add devices in the FLIR Secure™ app, see 17.1.1 Connect to Your Mobile Device Using FLIR Secure™, page 109

**To modify a device:**
1. From the Home screen, tap a camera channel under the recorder you want to modify. The FLIR Secure™ app will stream live video from the selected camera channel.
2. Tap . The app opens a channel settings screen.
3. Swipe to the bottom of the screen and tap **DEVICE SETTINGS**.
4. The **Device Settings** screen appears. You can modify the name of your device, enable / disable mobile and device error notifications.
5. Tap **Save** after you make your changes.

**NOTE**
You can change the password of your recorder through the FLIR Secure™ app (for **Admin** users only). From the **Device Settings** screen, tap **Change password** and enter a new password for your recorder. Tap **CHANGE**. Your password is updated in the FLIR Secure™ app and recorder.
To delete a device:

1. From the Home screen, tap a camera channel under the recorder you want to delete. The FLIR Secure™ app will stream live video from the selected camera channel.

2. Tap 🌋. The app opens a channel settings screen.

3. Swipe to the bottom of the screen and tap DEVICE SETTINGS.

4. The Device Settings screen appears. Swipe to the bottom of the screen and tap REMOVE DEVICE.

5. A confirmation pop-up appears, tap OK.
17.1.3 Android Phone

17.1.3.1 FLIR Secure™ Interface

Home Screen

1. **+**: Tap to add new devices or create new groups.
2. **i**: Tap to view the FLIR Secure™ app information. You can also log out from the FLIR Secure™ app in this screen by tapping **Log Out**.
3. **Device Name / ID**
4. **VIEW ALL**: Tap to stream live video from all connected cameras. Tap (hold for one second) and drag a camera channel to rearrange it.
5. **Camera channels**
Connecting to your System Using Smartphone or Tablet Apps

Single Channel Live View

1. **Channel number / channel name**
2. **Playback History**: Tap to view recorded videos saved on your recorder's hard drive.
3. **Live View**: Double-tap to zoom in. Turn your mobile device sideways to view in landscape mode, or hold upright to view in portrait mode.
4. **Disconnect camera channel**: Tap to disable live video, video recording, and push notifications. Tap again to enable the disconnected camera.
5. ****: Tap to open channel settings for the selected camera channel. You can change the channel name, enable PTZ controls, enable camera's microphone (for audio-enabled cameras only), and enable motion detection notification for the selected camera channel. Tap **SAVE** after you make your changes. On the channel settings screen, swipe to the bottom of the screen and tap **Device Settings** to view your device information. You can also change the device name, enable mobile notifications for your device, and check the Cloud subscription plan for your camera channels.
6. **Quick Playback**: Tap to play back video from the last 30 seconds for the camera channel. Tap anywhere on the video to pause / play the playback.
7. **Enhance Res**: Tap to enhance the resolution of the camera image.
8. **Snapshot**: During single-channel live view and quick playback mode, tap to take a screenshot of the currently-selected channel. Your mobile device must be in portrait mode.

17.1.3.2 Creating Groups

The **CREATE GROUP** function allows you to group multiple cameras from various devices in your FLIR Secure™ account. You can then quickly bring up the selected group of cameras in Live View without having to individually select each camera.
1. From the home screen, tap +.
2. Tap CREATE GROUP. The FLIR Secure™ app displays all cameras that are connected to your FLIR Secure™ account.

3. Tap the Name text box and enter a group name of your choice.
4. Select the cameras you would like to include in the new group and tap **CREATE**.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can add a maximum of 8 cameras in a group.</td>
</tr>
</tbody>
</table>

5. On the home screen, you will notice a new tab called **GROUPS**. Tap to view the new group you created.

6. Tap the group to stream live video from all the cameras in the group.
17.1.3.2.1 How to Edit a Group

To edit a group:
1. On the home screen, tap the GROUPS tab.
2. Tap next to the group you want to edit. The Edit Group screen appears.
3. Tap SAVE after you make your changes.

NOTE
Tap the Name text box to rename your group.

17.1.3.2.2 How to Delete a Group

To delete a group:
1. On the home screen, tap the Groups tab.
2. Tap next to the group you want to edit. The Edit Group screen appears.
3. Tap next to SAVE.
4. Tap Delete.
5. A confirmation pop-up appears, tap DELETE. Your group is deleted.
17.1.3.3 Using History Mode

History mode allows you to view recorded video saved on your recorder’s hard drive.

**To use History mode:**

1. From the Home screen, tap **VIEW ALL** next to the device name / device ID of the recorder you would like to play back from. The FLIR Secure™ app will stream live video from all cameras connected to your recorder.

2. Tap 🔄.
3. The History screen appears.

**History Screen**

- 1. Go back to Live View
- 2. Device Name / Device ID of your recorder
- 3. Play multiple recordings within a desired time frame.
- 4. Tap to select a time scale. You can search recordings by week, day, hour, or minute.
- 5. Tap the left / right arrow to select the day you would like to play back from.

**NOTE**

If you select WEEK as the time scale, this becomes a range of dates, for example: May 08 — May 14.

- 6. Changes according to the time scale selected. For example, if you select DAY as your time scale, this area shows: 12 AM, 4 AM, 8 AM, etc.
- 7. Swipe up / down to select the camera channel you would like to play back from.
- 8. Swipe left / right to search for recordings. Tap inside the timeline to select the playback time. Playback starts immediately at the selected time.

**NOTE**

- Motion recording
- Continuous recording

**NOTE**

Recordings are color-coded: orange for motion recording and blue for continuous recording. No color indicates that no recordings are available.
Connecting to your System Using Smartphone or Tablet Apps

**Playback Controls:**

1. Channel, day, and time indicator
2. Tap anywhere in the playback video to pause / play.
3. Indicates the type of recording, for example: motion or continuous event.
4. **Playback duration**: Shows the length of the recording and how much has been viewed. You can tap and drag inside the bar to select the time you wish to view.

**17.1.3.3.1 How to Play Multiple Recordings**

To play multiple recording within a desired time frame for a single channel:

1. From the Home screen, tap the camera channel under the recorder you would like to play back from. The FLIR Secure™ app will stream live video from the selected camera channel.
2. Tap . The **History** screen appears.
3. Tap . The **Play Recordings** screen appears.
4. **Play Recordings Screen**

![Playback interface](image)

1. Select the time scale. You can search recordings by week, day, hour, or minute.
2. Tap the left / right arrow to select the day you would like to play back from.
3 and 4: Playback start and end markers
5. Tap and drag the markers to set a time frame for playback. The marker on the left sets the start time for playback and the marker on right sets the end time.
6. Tap 🎬. The playback will start within the time frame that you selected.

### NOTE

Tap ⬅️ / ➔️ to play the previous / next playback video, respectively.

17.1.3.4 **How to Manage Devices in the FLIR Secure™ app**

You can add, delete, or modify your devices using the FLIR Secure™ app:

To add devices in the FLIR Secure™ app, see 17.1.1 *Connect to Your Mobile Device Using FLIR Secure™*, page 109

**To modify a device:**

1. From the Home screen, tap the camera channel under the recorder you want to modify. The FLIR Secure™ app will stream live video from the selected camera channel.
2. Tap 📡. The app opens a channel settings screen.
3. Swipe to the bottom of the screen and tap **Device Settings**.
4. The **Device Settings** screen appears. You can modify the name of your device, enable / disable mobile and device error notifications.
5. Tap **SAVE** after you make your changes.

### NOTE

You can change the password of your recorder through the FLIR Secure™ app (for **Admin** users only). From the **Device Settings** screen, tap **Change password** and enter a new password for your recorder. Tap **CHANGE**. Your password is updated in the FLIR Secure™ app and recorder.
To delete a device:

1. From the Home screen, tap a camera channel under the recorder you want to delete. The FLIR Secure™ app will stream live video from the selected camera channel.
2. Tap 🛠. The app opens a channel settings screen.
3. Swipe to the bottom of the screen and tap Device Settings.
4. The Device Settings screen appears. Swipe to the bottom of the screen and tap REMOVE DEVICE.
5. A confirmation pop-up appears, tap OK.
Free DDNS service is available as an optional connectivity method to connect to your system over the Internet.

DDNS Service is not required to connect to your system, since the system supports FLIR Cloud™. For details on setting up your system using FLIR Cloud™, see 15 Connecting to Your System Over the Internet on PC or Mac, page 78.

### 18.1 Accessing your System within a Local Network (LAN)

You can connect to your system through using the Client Software through the local area network (LAN). It is recommended to confirm connectivity over a local network before setting up your system for DDNS connectivity.

#### 18.1.1 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system. Connect the other end of the Ethernet cable to an empty LAN port (usually numbered 1–4) on your router.
3. Reconnect the power adapter to power the system back on.

18.1.2 Step 2 of 3: Obtain the System's Local IP Address

1. Right-click to open the Quick Menu and click Info. Enter the system user name (default: admin) and password (default: 000000).

2. Write down the IP Address of the system.
   - A local IP looks something like this: 192.168.5.118.

18.1.3 Step 3 of 3: Connect to the System's Local IP Address

Follow the steps below to confirm connectivity over a local network on a PC or Mac.

To connect using the system's local IP address:

1. Download and install the client software. To find the client software visit www.lorextechnology.com, search for the model number of your product, click on your product in the search results, and click on the Downloads tab.
   - PC Users: Download and install the Client Software for PC.
   - Mac Users: Download and install the Client Software for Mac. Double click to extract the software. Drag the software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon from the desktop or Applications list.
3. Log into the Client Software using the Client Software user name (default: `admin`) and password (default: `admin`) and then click `Login`.

4. The client scans your LAN for connected systems. Check your system (a) and click `Add` (b).

5. Enter the password for your system (default: `000000`) and click `OK`.

6. If this is the first time you are connecting, you will be prompted to change the system password.
7. Enter a new 6 character password and click **OK**. This password will be used to connect to your system from now on.

8. Click ![image](image1.png) then ![image](image2.png).

9. Click and drag **Default Group** to the display window to open your cameras in live view.

**Result**

![](image3.png)

### 18.2 DDNS Setup—Access your System Remotely over the Internet

Setting up DDNS connectivity allows you to view your system from any computer or compatible mobile device with Internet access.
To set up remote connectivity with your system, you must:

1. Port forward the HTTP port (default: 80) and Client port (default: 35000) on your router to your system's IP address.
2. Create a DDNS account.
3. Enable DDNS on the system.
4. Test the remote connection by entering your DDNS address in the client software.

### 18.2.1 Step 1 of 4: Port Forwarding

You **must** port forward the HTTP port (default: 80) and Client port (default: 35000) on your router to your system's IP address before you can remotely connect to your system. There are several methods to port forward your router:

- Use the **Auto Port Forwarding Wizard** (PC only) to port forward the required ports (see [www.lorextechnology.com](http://www.lorextechnology.com) for details). For instructions, see the Auto Port Forward Wizard manual on [www.lorextechnology.com](http://www.lorextechnology.com).

- Manually port forward the required ports on your router to your system's IP address by following your router manufacturer's instructions. For more information on port forwarding, see the reference guides on [www.lorextechnology.com](http://www.lorextechnology.com).

**NOTE**

If the above ports are not forwarded on your router, you will not be able to access your system remotely.

### 18.2.2 Step 2 of 4: Create a DDNS Account

Lorex offers a free DDNS service for use with your system. A DDNS account allows you to set up a web site address that points back to your local network. This allows you to connect to your system remotely. You must create a DDNS account in the same network as your system.

**To setup your free Lorex DDNS account:**

1. In your browser, go to [http://www.lorexddns.net](http://www.lorexddns.net) and click **Step 1**.

2. The My Lorex account login screen opens (if you are already logged in, skip to step 4). Create a new account or log into an existing account. To create a new account, fill in the required fields on the right and click **Create Account**.
3. Click **Warranties** to register your product for warranty.

![Warranties page]

**NOTE**

Warranty registration is required to register for DDNS.

4. The Warranty page opens. Click **Activate Warranty** to register your product for warranty.

5. Under **Your Address**, select an address or click **Enter a New Address** to create a new address. Fill in your address information and click **Create Address**.

![Activate Warranty and Create Address]
6. Fill in the warranty registration form with your product and purchase details. Check the sticker underneath your system for the Product Model Number and Serial Number. You can also upload a scan, photo, or electronic copy of your receipt or bill of sale. Click **Save Warranty**.

7. A page pops up to prompt you to register your product for Lorex DDNS. Click **Set Up a New DDNS**.

8. Configure the following:
8.1. **Product Warranty**: Select the product warranty you created in the previous steps.

8.2. **Device Name**: Enter a name for your device. You can enter your name, business name, or anything of your choice. This is used to identify this device in your list of activated DDNS accounts that appears anytime you visit the DDNS page.

8.3. **MAC Address**: Enter the MAC address of your Lorex product. To find the MAC address:

   - Right-click to open the Quick Menu and click **Info**. Enter the system user name (default: admin) and password (default: 000000).

8.4. **URL Request**: Enter the web site address that will be used to connect to your Lorex product. For example, if you enter tomsmith, the address to access your video will be http://www.tomsmit.lorexddns.net.

9. Click **Save** to register your product for DDNS. A confirmation email will be sent to the email address used to register for My Lorex. **You will need this information to enable remote access to your system.** Record your information below:

<table>
<thead>
<tr>
<th>Domain name/URL Request:</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDNS User Name:</td>
</tr>
<tr>
<td>Device DDNS password:</td>
</tr>
</tbody>
</table>
18.2.3 Step 3 of 4: Enable DDNS on the System

To enable DDNS in your System:

1. Right-click and click **Main Menu**. Enter the system password if prompted.

2. Click **Network** and then click **Network>DDNS**.

3. Check **Enable**.

4. Under **Domain Name**, enter the Domain Name/URL Request your received in the email after registering for DDNS.

5. Under **User Name**, enter your DDNS User Name.

6. Under **Password**, enter your DDNS Device password.

7. Click **OK** to save your settings.

---

**NOTE**

Please allow 10–15 minutes for the DDNS servers to update with your new DDNS address before attempting to connect.

18.2.4 Step 4 of 4: Connect to the System’s DDNS Address

**NOTE**

Please allow 10–15 minutes for the DDNS servers to update with your new DDNS address before attempting to connect.

To connect using the system’s DDNS address:

1. Download and install the client software on a remote computer. To find the client software visit [www.lorextechnology.com](http://www.lorextechnology.com), search for the model number of your product, click on your product in the search results, and click on the **Downloads** tab.

   - **PC Users**: Download and install the **Client Software for PC**.
   - **Mac Users**: Download and install the **Client Software for Mac**. Double click to extract the software. Drag the software to **Applications**.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (🔗) from the desktop.
3. Log into the Client Software using the Client Software user name (default: admin) and password (default: admin) and then click Login.

4. Click Add Device.

5. Enter the following:
5.1. Check **By IP/Domain** to add a system using the DDNS address.

5.2. **Device Name**: Choose a name for your system of your choice.

5.3. **IP/DDNS Address**: Enter the Domain Name/URL Request you received in the email when you registered for DDNS followed by `.lorexddns.net`.

5.4. **Client Port**: Enter the Client Port (default: **35000**).

5.5. **User Name**: Enter the system User Name (default: **admin**).

5.6. **Password**: Enter the system Password (default: **000000**).

6. Click **Add**. If this is the first time you are connecting, you will be prompted to change the system password.
7. Enter a new 6 character password and click OK. This password will be used to connect to your system from now on.

8. Click then .

9. Click and drag Default Group to the display window to open your cameras in live view.

Congratulations! You can now connect over the Internet to view and playback video on your computer.
You can connect PTZ cameras (not included) to the system. You must use Lorex IP PTZ cameras with the system. Lorex IP PTZ cameras can accept PTZ commands directly through the Ethernet cable. There is no need to run special wiring to use PTZ cameras.

To connect a PTZ camera to the system:

1. Right-click and click Main Menu. Enter the system user name (default: admin) and password (default: 000000) if prompted.
2. Click Setting>Pan/Tilt/Zoom.
3. Under Channel, select the channel your PTZ camera is connected to.
4. Under PTZ Type, select Remote.
5. Click OK. You can now control your PTZ camera using the system.

19.1 Controlling a PTZ Camera (Local NVR)

1. In Live View, click the channel that has the PTZ camera connected to open in full-screen.
2. Right-click and click PTZ. Enter the system user name and password if prompted. The PTZ menu opens.
3. Use the on-screen PTZ controls to control the camera.

PTZ Controls

1. **Direction keys**: Click to pan and tilt the camera. Click SIT to stop the current action.
2. **Mouse PTZ**: Click to activate mouse PTZ mode. In mouse PTZ mode:
   - Click and drag to move the camera.
   - Use the scroll wheel to zoom in and out.
   - Right-click to exit and return to normal PTZ controls.
3. **Zoom/Focus/Iris**: Click +/- to adjust the zoom, focus, and iris.
4. **Advanced controls**: Click to open advanced PTZ controls.
5. **Speed**: Enter the PTZ speed.
19.2 Advanced PTZ Controls

Advanced PTZ controls can be used to save camera positions and cycle through various positions, and automate camera actions.

To open advanced PTZ controls:

• Click the arrow in the PTZ control window to open advanced controls.

Advanced PTZ controls overview:

1. **No.**: Select the number of the action you want to perform.
2. **Not supported**.
3. **PTZ camera menu**: Click to open the camera’s OSD menu. This may not be supported on all camera models.
4. **Preset**: Click to call the selected preset.
5. **Autopan**: Click to start autopan. During autopan, the camera will continuously pan 360°.
6. **Tour**: Click to run the selected tour.
7. **Flip**: Click to flip the camera 180°.
8. **Pattern**: Click to run the selected pattern.
9. **Reset**: Click to move the camera to the home position.
10. **Auto scan**: Click to run the selected autoscan.
11. ****: Click to open the PAN/TILT/ZOOM menu, where you can set up Presets, Tours, Patterns, and Auto Scans.

19.2.1 Presets

Presets will save a camera position for quick retrieval.

To add presets:

1. Click **to open the PAN/TILT/ZOOM menu.**
2. Click the **Preset** tab.

![Preset Tab Image]

3. Enter the number of the preset you want to create under **Preset**.
4. Move the camera to the desired position and click **Set**.

**To go to a preset:**

- Under **No.**, select the number of the preset you would like to go to and click.

19.2.2 **Tours**

Tours will cycle through a set of presets.

**To create a tour:**

1. Click to open the **PAN/TILT/ZOOM** menu.
2. Click the **Tour** tab.

![Tour Tab Image]

3. Under **Patrol No.**, select the tour you would like to configure.
4. Under **Preset**, select a preset you would like to add to the tour.
5. Click **Add Preset**.
6. Repeat steps 4 and 5 to add additional presets to the tour.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Del Tour</strong> to clear all presets from a tour.</td>
</tr>
</tbody>
</table>

**To run a tour:**

- Under **No.**, select the number of the tour you would like to go to and click.

19.2.3 **Pattern**

Patterns automatically cycle the camera between two positions.

**To create a pattern:**

1. Click to open the **PAN/TILT/ZOOM** menu.
2. Click the **Pattern** tab.

   ![Pattern tab](image)

3. Under **Pattern**, enter the pattern you would like to configure.
4. Move the camera into the desired start position and click **Begin**.
5. Move the camera into the desired end position and click **End**.

   **To run a pattern:**

   - Under **No.**, select the number of the pattern you would like to go to and click.

19.2.4  **Auto Scan**

An auto scan automatically cycles between a left and right point.

   **To create a new auto scan:**

   1. Click to open the **PAN/TILT/ZOOM** menu.
   2. Click the **Border** tab.

   ![Border tab](image)

   3. Move the camera into the desired left position and click **Left**.
   4. Move the camera into the desired right position and click **Right**.

   **To run an auto scan:**

   - Click
The models listed below come pre-installed with the following:

- **LNR608 (8-channel):** This system comes with a pre-installed 3.5” SATA hard drive. You can install up to two hard drives up to a maximum size of 6TB each.

- **LNR616 (16–channel):** This system comes with a pre-installed 3.5" SATA hard drive. You can install up to four hard drives up to a maximum size of 6TB each.

- **LNR632 (32–channel):** This system comes with two (2) pre-installed 3.5” SATA hard drives. You can install up to four hard drives up to a maximum size of 6TB each.

### 20.1 Installing a Hard Drive

**CAUTION**

Make sure that the system is OFF and the power cable is disconnected before removing/installing the hard drive.

To install the hard drive:

1. Insert hard drive screws (4x) on the hard drive and tighten them half way.

2. Power off the system, and unplug all cabling from the system.

3. Remove the rear panel screws (4x). Remove the cover.

4. Place the hard drive over one of the sets of screw slots on the bottom of the system and then slide the hard drive into place. The SATA connectors on the hard drive should face the center of the unit.
5. Turn the system over carefully. Tighten the hard drive screws (4x) to secure the hard drive.

![Image](image1)

**CAUTION**

Hold the hard drive in place when turning the system over to prevent damage to the system.

6. Connect the SATA power and data cable to the hard drive.

![Image](image2)

7. Replace the cover and cover screws (4x).

![Image](image3)

**NOTE**

After installation, you must format the hard drive in order to use it with the system. See 20.3 Formatting Hard Drives, page 147.

### 20.2 Removing the Hard Drive

**CAUTION**

Make sure that the system is OFF and ALL power adapters have been disconnected before removing/installing the hard drive.

1. Power off the system, and unplug all cabling from the system.
2. Remove the rear panel screws (4x). Remove the cover.
3. Turn the system over and loosen the hard drive screws (4x), but do not remove them.

4. Disconnect the SATA power and data cable from the hard drive.

5. Carefully turn the system over. Slide the hard drive and then lift it out of the system.

6. Replace the cover and cover screws (4x).

**NOTE**

After installation, you must format the hard drive in order to use it with the system. See 20.3 Formatting Hard Drives, page 147.

**20.3 Formatting Hard Drives**

You must format hard drives before you may use them with the system.
CAUTION

Formatting the HDD erases all data on the hard disk. This step cannot be undone. System settings will not be erased.

To format the hard drive:

1. From the Main Menu, click and then click Storage>HDD Manager.

2. Select the hard drive you would like to format and then click Format. Click OK to confirm.

3. Click OK to save changes. The system will restart to complete the formatting process.
The system can record audio on any channels that have audio-capable cameras connected to them. You must have an audio-capable camera (not included) in order to record audio using the system. The camera must have a built-in microphone or an audio input cable (for example RCA) for connecting a self-powered microphone.

**NOTE**

The MIC IN/OUT ports on the rear panel of the system are not supported and cannot be used for audio recording.

Audio recording without consent is illegal in certain jurisdictions. Lorex Technology Inc. assumes no liability for use of its products that does not confirm with local laws.

### 21.1 Step 1 of 2: Connecting an audio-capable camera

Connect the camera to the NVR or network. If the camera is connected to the network, add it to the NVR. For details, see 5.11 *Connecting Cameras to the Local Area Network (LAN)*, page 10.

Option A: Connect a camera with a built-in microphone.
Option B: Connect a camera with audio input.

NOTE
The microphone must have its own power source.

21.2 Step 2 of 2: Configuring audio recording
1. Right-click and click Main Menu. Enter the system user name (default: admin) and password (default: 000000) if prompted.

2. Click and select Recording>Recording.

3. Under Channel, select the channel where the audio-capable camera is connected.
4. Under Audio/Video, check the box on the left to enable audio recording.
5. Click OK to save changes.
Troubleshooting

When a malfunction occurs, it may not be serious and can be corrected easily. The following describes the most common problems and solutions. Please refer to the following before calling Lorex Technical Support:

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| • System is not receiving power, or is not powering up. | • Cable from power adapter is loose or is unplugged. | • Confirm that all cables are connected correctly.  
• Confirm that the power adapter is securely connected to the back of the unit.  
• Power switch is set to OFF ( ) position. | • Confirm that the power switch is in the ON (I) position. |
| • Cables are connected, but system is not receiving sufficient power. | | • Confirm that the system is powered on (LED indicators on the front should be ON).  
• If the unit is connected through a power bar or surge protector, try bypassing the bar and connecting the power directly to the wall outlet.  
• Confirm that there is power at the outlet:  
  ◦ Connect the power cable to another outlet.  
  ◦ Test the outlet with another device (such as a lamp or phone charger). |
| • Hard drive is not detected by the system. | • Hard drive cables are loose or not properly connected. | • Remove the housing and check that hard drive cables are firmly connected.  
• There is no hard drive in the system. | • Open the housing and install compatible hard drive. Make sure to format the drive after installing. For details, see . |
| • Hard drive is full (0%) and the unit is no longer recording. | • Overwrite is not enabled. | • From the Main Menu, select >Setting>General>General. Select Overwrite under HDD Full and click OK.  
• There is no picture on monitor/TV after connecting it to the system. | • Monitor/TV not detected by system. | • Power off the monitor/TV and system. Power on the monitor/TV, and then power on the system.  
• Input channel for system not selected on monitor/TV. | • On the monitor/TV, select the input channel the system is connected to.  
• Video cable is loose or has become disconnected. | • Check the video cable connection to the system and monitor/TV. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mouse not detected by system.</td>
<td>• Mouse cable is not firmly connected to the system. Mouse is not connected to the system.</td>
<td>• Firmly connect the mouse cable to one of the USB ports.</td>
</tr>
<tr>
<td></td>
<td>• System needs to be reset</td>
<td>• Power off the system (disconnect power cable). Firmly connect a USB mouse to one of the USB ports. Reconnect the power cable to the DC 12V port on the rear panel.</td>
</tr>
<tr>
<td>• There is no picture on selected channels / camera picture is not being displayed.</td>
<td>• Camera cables are loose or have become disconnected.</td>
<td>• Check the camera video cable and connections. • Disconnect and reconnect the cable at the system and at the camera. • Try moving the camera to another channel or use another cable.</td>
</tr>
<tr>
<td>• The system beeps at startup.</td>
<td></td>
<td>• The beep at startup is normal.</td>
</tr>
<tr>
<td>• The system beeps during motion detection.</td>
<td>• Motion detection is enabled and the alarm buzzer is activated.</td>
<td>• Open the Main Menu and click &gt;Event&gt;Motion&gt;Motion Detect. Uncheck Buzzer for each channel and click Apply.</td>
</tr>
<tr>
<td>• I am not receiving email notifications.</td>
<td>• Email notification is disabled.</td>
<td>• Ensure you have configured email notification. For details, see 14.3.5 Configuring Email Alerts, page 55. • Send Email setting not enabled in Event menu.</td>
</tr>
</tbody>
</table>
# LNR600 Series System Specifications

## 23.1 System

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Linux (embedded)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pentaplex</td>
<td>Simultaneous View, Record, Playback, Backup &amp; Remote Monitoring</td>
</tr>
<tr>
<td>Number of Channels</td>
<td>8/16 Channels</td>
</tr>
</tbody>
</table>

## 23.2 Inputs/Outputs

<table>
<thead>
<tr>
<th>Video IN</th>
<th>8ch: 8 PoE Video Input</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>16ch: 16 PoE Video Input</td>
</tr>
<tr>
<td>Video OUT</td>
<td>No</td>
</tr>
<tr>
<td>VGA OUT</td>
<td>Yes</td>
</tr>
<tr>
<td>HDMI</td>
<td>Yes</td>
</tr>
<tr>
<td>Audio IN</td>
<td>1 Line IN (RCA) for service only</td>
</tr>
<tr>
<td>Audio OUT</td>
<td>1 Line OUT (RCA) for service only</td>
</tr>
<tr>
<td>USB Port</td>
<td>1 at the back, 1 at the front</td>
</tr>
<tr>
<td>Alarm IN</td>
<td>4 Alarm IN</td>
</tr>
<tr>
<td>Alarm OUT</td>
<td>2 Alarm OUT</td>
</tr>
<tr>
<td>Video Output Resolution</td>
<td>3840x2160, 1920x1080, 1280x1024, 1280x720, 1024x768</td>
</tr>
<tr>
<td>PTZ Control</td>
<td>Lorex IP PTZ cameras only</td>
</tr>
</tbody>
</table>

## 23.3 Display

<table>
<thead>
<tr>
<th>Display Split</th>
<th>8ch: 1/4/8</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>16ch: 1/4/8/9/16</td>
</tr>
<tr>
<td>Live Display Speed</td>
<td>8ch: 240fps NTSC / 200fps PAL</td>
</tr>
<tr>
<td></td>
<td>16ch: 480fps NTSC, 400fps PAL</td>
</tr>
<tr>
<td>OSD</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>System Navigation</td>
<td>USB mouse, IR remote control, front panel buttons</td>
</tr>
<tr>
<td>Motion Area Setting</td>
<td>Fixed Grid (22x18)</td>
</tr>
<tr>
<td>Sensitivity Levels</td>
<td>100</td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>Automatic over the Internet &amp; via USB device and network</td>
</tr>
<tr>
<td>User Authority</td>
<td>By user group</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>Auto time sync by NTP server</td>
</tr>
</tbody>
</table>

## 23.4 Recording

<table>
<thead>
<tr>
<th>Video Compression</th>
<th>H.264 / H.265</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Compression</td>
<td>G.711</td>
</tr>
<tr>
<td>Resolution</td>
<td>720p (1280x720), 1080p (1920x1080) – 4K-8MP (3840x2160)</td>
</tr>
<tr>
<td>Record Rate</td>
<td>8ch: 240fps@720p/1080p/3MP/4MP/8MP</td>
</tr>
<tr>
<td></td>
<td>16ch: 480fps@720p/1080p/3MP/4MP/8MP</td>
</tr>
<tr>
<td>Recording Resolution Setting</td>
<td>Per camera for different resolutions</td>
</tr>
</tbody>
</table>
### 23.5 Playback and Backup

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playback Channel</td>
<td>1/4/8</td>
</tr>
<tr>
<td>Playback Speed Variable</td>
<td>Variable Max 16x</td>
</tr>
<tr>
<td>Playback Players</td>
<td>Backup Player</td>
</tr>
<tr>
<td>Search</td>
<td>By time &amp; event</td>
</tr>
<tr>
<td>Log Search</td>
<td>Up to 1,000 lines for motion detected, configuration changes, connects/disconnects and video loss</td>
</tr>
<tr>
<td>Audio Play</td>
<td>Yes (audio camera required)</td>
</tr>
</tbody>
</table>

### 23.6 Storage & Archive

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage</td>
<td>Up to 2 HDD’s (SATA)</td>
</tr>
<tr>
<td>Maximum Capacity</td>
<td>Up to 2x6TB</td>
</tr>
<tr>
<td>Backup Media</td>
<td>USB flash drive &amp; HDD</td>
</tr>
<tr>
<td>Backup File Format</td>
<td>DAV or ASF file</td>
</tr>
</tbody>
</table>

### 23.7 Connectivity

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Connection</td>
<td>FLIR Cloud™ / FLIR Secure™</td>
</tr>
<tr>
<td>Supported Operating Systems</td>
<td>Windows™, Mac OS X</td>
</tr>
<tr>
<td>Remote Software</td>
<td>Client Software (PC&amp;Mac)</td>
</tr>
<tr>
<td>Email Notification</td>
<td>Text with snapshot</td>
</tr>
<tr>
<td>Instant Smart Phone &amp; Tablet Support</td>
<td>iPad®, iPhone®, Android™</td>
</tr>
<tr>
<td>DDNS</td>
<td>Free Lorex DDNS</td>
</tr>
<tr>
<td>System Configuration</td>
<td>Full setup configuration over network</td>
</tr>
<tr>
<td>Ports</td>
<td>Programmable by user</td>
</tr>
<tr>
<td>Network Protocol</td>
<td>HTTP, IPv4/IPv6, TCP/IP, UPNP, RTSP, UDP, SMTP, NTP, DHCP, DNS, PPPOE, DDNS, FTP, IP Filter</td>
</tr>
<tr>
<td>Network Interface</td>
<td>10/100/1000-Base-TX, RJ-45</td>
</tr>
<tr>
<td>Network Bit Rate</td>
<td>320Mbs total, 48 – 8192kbps per camera</td>
</tr>
</tbody>
</table>

### 23.8 General

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Consumption</td>
<td>Approx. 15W (No HDD included)</td>
</tr>
<tr>
<td>Supply Voltage</td>
<td>100VAC-240VAC, 50/60Hz</td>
</tr>
</tbody>
</table>
23.9 Recording Resolution (Pixels) & Maximum Speed (FPS — Frames per second)

<table>
<thead>
<tr>
<th>Model</th>
<th>720p 1280x720</th>
<th>1080p 1920x1080</th>
<th>3MP 2048x1536</th>
<th>Super HD 4MP 2688x1520</th>
<th>4K 3840x2160</th>
</tr>
</thead>
<tbody>
<tr>
<td>8ch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>240</td>
<td>240</td>
<td>240</td>
<td>240</td>
<td>240</td>
</tr>
<tr>
<td>Per channel</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>16ch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>480</td>
<td>480</td>
<td>480</td>
<td>480</td>
<td>480</td>
</tr>
<tr>
<td>Per channel</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
</tbody>
</table>

As our products are subject to continuous improvement, Lorex Corporation and its subsidiaries reserve the right to modify product design, specifications, and prices without notice and without incurring any obligation. E&OE
This product has been certified and found to comply with the limits regulated by FCC, EMC, and LVD. Therefore, it is designated to provide reasonable protection against interference and will not cause interference with other appliance usage. However, it is imperative that the user follows the guidelines in this manual to avoid improper usage, which may result in damage to the product, electrical shock and fire hazard injury.

24.1 FCC/IC Notice

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception (which can be determined by turning the equipment on and off), the user is encouraged to try to correct the interference by one or more of the following measures:

1. Reorient or relocate the receiving antenna.
2. Increase the separation between the equipment and receiver.
3. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
4. Consult the dealer or an experienced radio or television technician for assistance.

24.2 Modification

Any changes or modifications not expressly approved by the grantee of this device could void the user's authority to operate the device.

Toute modification non approuvée explicitement par le fournisseur de licence de l'appareil peut entraîner l'annulation du droit de l'utilisateur à utiliser l'appareil.

24.3 ROHS

This product is fully compliant with the European Union Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment ("RoHS") Directive (2002/95/EC). The RoHS directive prohibits the sale of electronic equipment containing certain hazardous substances such as lead, cadmium, mercury, and hexavalent chromium, PBB, and PBDE in the European Union.